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Preface
This document describes the requirements and tasks to integrate data from external sources in
Cisco StadiumVision Director Release 3.2.
The content is intended for Cisco StadiumVision system administrators, content managers, and technical
field engineers who are responsible for designing and deploying Cisco StadiumVision solutions. It is
expected that readers of this document are familiar with basic IP networking, have a general
understanding of the sports and entertainment business, and understand the objectives and operations of
live events.

Document Revision History
Table 1 lists the technical changes made to this document since it was first published.
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Table 1

Document Revision History

Date

Change Summary

October 20, 2014

Revised the default behavior system-wide of the External Content Application
from disabled to enabled in the following topics:

October 16, 2014

April 21, 2014

•

“Activating External Content Integration System-Wide From the
Management Dashboard” section on page 44.

•

“Deactivating the External Content Integration Application From the
Management Dashboard” section on page 60.

The following updates were made:
•

Removed reference to support of Oracle and PostGresSQL database sources
in the “Supported External Content Sources” section on page 3, “Generic
Data Source Message Types” section on page 7 and the “Configuring the
Connection to a Generic Data Source” section on page 26.

•

Added note that only one database type can be deployed at a time in the
“Supported External Content Sources” section on page 3 and the
“Configuring the Connection to a Generic Data Source” section on page 26.

•

Revised the “Differences Between the DMB Application and External
Content Integration for POS Data and Menu Board Creation” section on
page 10.

•

Added “Deployment Guidelines for POS Data Integration and the Widgets
Tool for Menu Creation” section on page 11.

•

Added topics for configuration of POS data sources in the “Configuring
External Content Integration in Cisco StadiumVision Director” module on
page 13.

•

Revised Figure 1 and the configuration requirements in the “Prerequisites
for Configuring OES ISC9000 Scoreboard Integration” section on page 14.

•

Corrected the range of P2S images from 2-5 to 1-5 in Table 6 on page 71.

•

Added a new menu board widget example in the “Menu Board Widget Using
DMB Themes Configuration Example” section on page 88.

First release of this document for Cisco StadiumVision Director Release 3.2.

Document Organization
Chapter

Description

“Overview of External Content
Integration in Cisco StadiumVision
Director”

Provides a high-level overview of the Cisco StadiumVision
Director’s integration with external data sources for content
ingestion and presentation.

“Configuring External Content
Integration in Cisco StadiumVision
Director”

Describes the requirements and how to configure support for
external data sources in Cisco StadiumVision Director.
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Obtaining Documentation and Submitting a Service Request

Chapter

Description

“Configuring Optional and
Advanced Tasks for External
Content Integration”

Describes additional tasks that can be performed to configure
and maintain External Content Integration in Cisco
StadiumVision Director.

“Designing the Layout of External
Content Using the Widgets Tool”

Describes how to design the layout for display of the data that
you have integrated and mapped for output in Cisco
StadiumVision Director using the External Content Integration
feature.

“Troubleshooting External Content
Integration in Cisco StadiumVision
Director”

Describes how to monitor and troubleshoot problems with
External Content Integration in Cisco StadiumVision Director.

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional
information, see the monthly What's New in Cisco Product Documentation, which also lists all new and
revised Cisco technical documentation, at:
http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
Subscribe to the What's New in Cisco Product Documentation as an RSS feed and set content to be
delivered directly to your desktop using a reader application. The RSS feeds are a free service. Cisco
currently supports RSS Version 2.0.
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Overview of External Content Integration in
Cisco StadiumVision Director
First Published: April 21, 2014
Revised: October 16, 2014

This module includes the following topics:
•

Introduction, page 1

•

Supported External Content Sources, page 3

•

Restrictions for External Content Integration, page 4

•

Information About NFL GSIS Integration in Cisco StadiumVision Director, page 4

•

Information About Scoreboard Integration in Cisco StadiumVision Director, page 5

•

Information About Generic Data Sources in Cisco StadiumVision Director, page 6

•

Information About Content Feeds in Cisco StadiumVision Director, page 8

•

Information About POS Data Sources in Cisco StadiumVision Director, page 10

•

Overview of the External Content Integration Interface, page 12

Introduction
Figure 1 shows a high-level overview of the content support in the External Content Integration feature
in Cisco StadiumVision Director.
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Figure 1

External Content Integration High-Level Overview

Release 3.2 Enhancements
The enhancements to the External Content Integration feature in Cisco StadiumVision Director
Release 3.2 includes support for the following updates:
•

Data Integration Enhancements, page 2

•

Widgets Tool Enhancements, page 3

Data Integration Enhancements
Cisco StadiumVision Director Release 3.2 supports the following updates for Data Integration:
•

Introduction of the following new data source types:
– Generic Data Source—Database source type

Supports automatic translation of MySQL and SQLServer database formats to XML data in
Cisco StadiumVision Director.
– Generic PoS

Allows any external POS data source that meets the XML schema requirements of the Cisco
StadiumVision Director POS API to be ingested for use in the External Content Integration
feature.
– Internal Database PoS

Allows POS data from stores that have been configured in Cisco StadiumVision Director to be
made available as a data source to be used and modified in the Widgets tool.
– Menu Theme

Allows the default menu theme data from the Cisco StadiumVision Director DMB application
to be made available as a data source so that this DMB theme content can be used and modified
in the Widgets tool.
For details about the default menu themes in the DMB application, see the “Appendix A: DMB
Default Menu Theme Reference” module in the Cisco StadiumVision Director Dynamic Menu
Board and Stores Configuration Guide, Release 3.0 and Later Releases.
•

Basic authentication through username and password properties.

•

HTTPS URL support.
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Widgets Tool Enhancements
Cisco StadiumVision Director Release 3.2 supports the following updates in the Widgets tool:
•

Font selector.
Only the Arial font is available by default.
Custom fonts are made available for selection in the Widgets tool by uploading additional fonts to
Cisco StadiumVision Director using the Software Manager. TrueType (.ttf) and OpenType (.otf)
fonts are supported. For more information about how to install custom fonts, see the Cisco
StadiumVision Director Software Installation and Upgrade Guide, Release 3.2.

•

List component.
The List component supports tabular data in the form of a group of one-dimensional lists (1xC),
where each list of data is one row by “C” number of columns. So, a table would consist of some
number of lists, each (1xC) in size, with each column able to be rendered as text or graphics.

Supported External Content Sources
Cisco StadiumVision Director Release 3.2 predefines the data structures to support the following
external content sources:
•

Atom Feed

•

Daktronics All Sport 5000 Scoreboard Controller (basketball and hockey only)

•

National Football League (NFL) Game Statistics and Information System (GSIS) Cumulative
Statistics

•

NFL GSIS Game Clock

•

OES ISC9000 Intelligent Scoreboard Controller (basketball and hockey only)

•

POS data sources:
– Generic PoS
– Internal Database PoS
– Menu Theme

•

RSS Feed (RSS 2.0)

In addition to these predefined data sources, Cisco StadiumVision Director also can support Generic
Data Sources from the following source types:
•

Note

Database—Supports automatic translation of MySQLand SQLServer database formats to XML data
in Cisco StadiumVision Director.

Only one database type can be deployed at a time.

•

FTP

•

HTTP

•

TCP

•

UDP
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Restrictions for External Content Integration
Before you configure External Content Integration, consider the following restrictions:
•

The External Content Integration feature is not venue aware. This means that any configuration
applies to all venues and cannot be made venue-specific.

•

The frequency of the scoreboard clock updates is no more than once per second and a delay of up to
2 seconds can occur.

•

Only basketball and hockey scoreboard statistics are currently supported.

•

RSS feed approvals must be done pre-ingestion of the content into Cisco StadiumVision Director.

•

Up to 5 images can be supported from a data source using the PicToScreen widget. For more
information on the Widgets tool, see the “Designing the Layout of External Content Using the
Widgets Tool” module.

•

Data from a generic data source is not cached in Cisco StadiumVision Director. This means that
DMPs must be able to reach any externally referenced source data (for example, referenced images)
on the network. If the DMPs do not have access to the external data source, then you need to set up
an intermediary server to cache external data internally to the Cisco StadiumVision Director
network.

•

The total data source data pushed for a single event script cannot exceed 16 KB in size when using
External Content Integration due to a limitation in the multicast packet size for pushing data to the
DMP.
If total data sources for a given script exceed 16 KB and you do not need to synchronize data across
many DMPs, then you can configure the new Data Pull component with your other configured
components in the widgets tool. The Data Pull component causes the DMP to pull data from Cisco
StadiumVision Director rather than have data be pushed by StadiumVision Director over multicast,
which overcomes the 16 KB maximum multicast packet size.

Caution

The import of any external flows must only be done by trained Cisco Systems personnel or partners due
to potentially severe risks to the normal operation of the External Content Integration system.

Information About NFL GSIS Integration in Cisco StadiumVision
Director
This section includes the following topics:
•

Network Considerations for NFL GSIS Integration, page 4

•

Supported NFL GSIS Data, page 5

Network Considerations for NFL GSIS Integration
The NFL GSIS statistics supported by the External Content Integration feature are transferred from data
stored on an NFL Stats-in-a-Box (SIAB) server installed at the venue using an FTP connection to the
Cisco StadiumVision Director server. The NFL SIAB server is a local server that connects to the central
NFL GSIS database external to the venue and managed by the NFL.
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Figure 2 shows a sample network architecture for NFL GSIS integration with Cisco StadiumVision
Director.

Note

The actual network configuration with the NFL network is site-dependent and could vary at your venue.
Figure 2

Network Architecture for NFL GSIS Integration

It is important to note that the network where the SIAB server is installed is not necessarily (and likely
not) on the same network where the Cisco StadiumVision Director server is installed. Therefore,
depending on your specific network configuration, you might have some network configuration to do to
ensure that the SIAB server is reachable by the Cisco StadiumVision Director server.
To configure the network connectivity to the NFL SIAB server you must specify the IP address, port,
data path, username, and password for the NFL SIAB server on the Cisco StadiumVision Director server.

Supported NFL GSIS Data
Cisco StadiumVision Director supports the NFL GSIS Game Clock and all of the statistics in the
Cumulative Statistics XML file (CumulativeStatisticsFile). For more information and documentation for
these statistics, go to:
http://www.nflgsis.com/gsis/
From the NFL GSIS Home page, click Documentation. Click the corresponding documentation links
for the Cumulative Statistics Report and the Real-time Game Information (Game Clock).

Information About Scoreboard Integration in Cisco
StadiumVision Director
This section includes the following topics:
•

Overview of Scoreboard Integration Support, page 5

•

Network Considerations for Scoreboard Integration, page 6

Overview of Scoreboard Integration Support
Cisco StadiumVision Director scoreboard integration allows you to display real-time information (such
as period, score, and clock) on Cisco StadiumVision Director TV displays.
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Figure 3 shows a high-level overview of the scoreboard integration support. Cisco StadiumVision
Director Release 3.0 supports the following devices and sports:

Note

•

Daktronics All Sport 5000 Scoreboard Controller (NBA basketball and hockey only)

•

OES ISC9000 Intelligent Scoreboard Controller (basketball and hockey only)

Beginning in Cisco StadiumVision Director Release 3.1.0-787 (SP1), support for Daktronics scoreboard
integration requires the addition of the Lantronix UDS1100-PoE box. This device must be configured to
allow connectivity to the Cisco StadiumVision Director server.
Figure 3

Scoreboard Integration High-Level Overview

Network Considerations for Scoreboard Integration
Cisco StadiumVision Director communicates with the supported scoreboard controllers through a User
Datagram Protocol (UDP) port connection. Both the corresponding controller interface and the
Cisco StadiumVision Director server must be configured to establish the network connectivity between
these devices.

Information About Generic Data Sources in Cisco StadiumVision
Director
Beginning in Cisco StadiumVision Director Release 3.1, support for external content integration with
generic data sources in Cisco StadiumVision Director is introduced. Generic data sources can be used
for other forms of XML sources that you want to ingest into Cisco StadiumVision Director whose format
does not conform to some of the standard out-of-the-box data source types such as RSS 2.0.

Note

If your data feed does not strictly conform to the standard format of the predefined data source types in
the External Content Integration feature, then the Generic Data Source type is recommended for best
results.
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Generic Data Source Message Types
The generic data source can be configured as one of the following message types:
•

Database—Supports automatic translation of MySQL and SQLServer database formats to XML data
in Cisco StadiumVision Director.

•

FTP

•

HTTP (including HTTPS)

•

TCP

•

UDP

Data Views
Data views can be configured to support ingestion of multiple feeds as an advanced data configuration
option. Data views allow you to merge data from multiple feeds and use an expression editor to select
certain data elements from those feeds to be put into a single combined data source for presentation. The
data source can be laid out for presentation using the PicToScreen or TextToScreen components of the
Widgets tool.
Figure 4 shows receipt of two independent RSS feed sources into Cisco StadiumVision Director with
data integration of those sources into a data view that is then re-ingested into the External Content
Integration feature as a single data source of the combined feeds.
Figure 4

Multiple RSS Feeds Combined into Single Data Source

The newly combined data source of the two RSS feeds can be bound to a TextToScreen component in
the Widgets tool to lay out its final presentation for use in the standard script/playlist publishing methods
of Cisco StadiumVision Director.
For more information about configuring data views, see the “Working with Data Views” section on
page 49.
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XML Schema for Generic Data Sources
If you want to use a generic data source in the External Content Integration feature, then you must be
able to provide the XML for a single sector (that is representative of all of the sectors) in the data feed.
This sample data can then be used for the configuration of your data source.

Information About Content Feeds in Cisco StadiumVision
Director
Cisco StadiumVision Director Release 3.1 enhances support for RSS feed design using the External
Content Integration feature. It includes support for a predefined RSS data feed, and an Atom feed.

Note

The legacy Ticker feature remains available from the Control Panel in Cisco StadiumVision Director.
This section includes the following topics:
•

Differences Between Legacy Ticker Feature and External Content Integration for RSS Support,
page 8

•

Predefined Feed Sources, page 9

Differences Between Legacy Ticker Feature and External Content Integration
for RSS Support
Table 1 provides a comparison of the differences between the legacy Ticker feature available from the
Control Panel, and the new RSS feed support available from the External Content Integration feature in
the Control Panel > Setup screen.
Table 1

Comparison of Ticker Feature with External Content Integration RSS Support

Feature

Customized Layout

UI Support for Content Approvals

Ticker (Control Panel)

No

Yes

External Content Integration RSS
(Control Panel / Setup)

Yes

No

When using External Content Integration to configure your RSS feeds, approvals must be done outside
of the Cisco StadiumVision Director software and prior to its ingestion by Cisco StadiumVision Director.
However, the External Content Integration feature allows you to customize the layout of your RSS
information on the display using the PicToScreen and TextToScreen components of the Widgets tool.
The primary advantage of the legacy Ticker feature is that you can do approvals of your content from
within the user interface, but you do not have any control over the layout design.
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Predefined Feed Sources
The External Content Integration feature in Cisco StadiumVision Director Release 3.1 adds support for
the following predefined data sources for RSS and Atom support:
•

Atom Feed

•

RSS Feed

Atom Feed Data Fields
Table 2 describes the data fields that are supported in Cisco StadiumVision Director for the predefined
Atom feed data source.
Table 2

Data Fields for Mapping Atom Feeds

Data Field

Description

Title

Title element in original Atom feed.

Content

Content element in original Atom feed.

Id

Id element in original Atom feed.

Image

First enclosure URL within a link element, if available. Otherwise, source
URL of the first HTML image element within content.

RSS Feed Data Fields
Table 3 describes the data fields that are supported in Cisco StadiumVision Director for the predefined
RSS feed data source, which can be used as a generic data source for other RSS feeds.
Table 3

Data Fields for Mapping RSS Feeds (Generic)

Data Field

RSS Feed

Title

Title element in original RSS feed.

Description

Description element in original RSS feed.

Link

Link element in original RSS feed.

Image

First enclosure URL, if available. Otherwise, source URL of the first
HTML image element within description.

Cisco StadiumVision Director External Content Integration Guide

9

Overview of External Content Integration in Cisco StadiumVision Director
Information About POS Data Sources in Cisco StadiumVision Director

Information About POS Data Sources in Cisco StadiumVision
Director
Cisco StadiumVision Director Release 3.2 introduces three new POS data sources:
•

Generic PoS
Allows any external POS data source that meets the XML schema requirements of the Cisco
StadiumVision Director POS API to be ingested for use in the External Content Integration feature.

•

Internal Database PoS
Allows POS data from stores that have been configured in Cisco StadiumVision Director to be made
available as a data source to be used and modified in the Widgets tool.

•

Menu Theme
Allows the default menu theme data from the Cisco StadiumVision Director DMB application to be
made available as a data source so that this DMB theme content can be used and modified in the
Widgets tool.

Differences Between the DMB Application and External Content Integration for
POS Data and Menu Board Creation
The Dynamic Menu Board (DMB) application is still supported in Release 3.2. If you have integrated
with a supported POS vendor using the DMB application in Cisco StadiumVision Director, then you can
continue to use that application to support your menu boards.
However, Release 3.2 provides a way for you to configure POS data sources that make the DMB store
data available for use within the Widgets tool to create and publish your menus. Using Data Integration
and the Widgets tool for your DMB store data also allows you to eliminate the need for creation of a
Gadget Archive (GAR) with Adobe Shockwave Flash (SWF) files.

Summary of DMB and External Content Integration Differences for Menu Creation
Table 4 provides a summary of the key functional differences between the DMB application and the
External Content Integration feature for POS data and menu creation.
Table 4

DMB Application and External Content Integration Differences for Menu Creation

Characteristic

DMB Application

External Content Integration

Concessionaire role support

Yes

No

Dynamic menu content updates

Yes

Yes

Flexible menu design

No

Yes

Font control

No

Yes

In-suite ordering

Yes

No

Vendor-dependent integration

Yes

No—But vendor must meet the XML
schema requirements for the Generic PoS
data source.

Widget layout tool support

No

Yes

Cisco StadiumVision Director External Content Integration Guide

10

Overview of External Content Integration in Cisco StadiumVision Director
Information About POS Data Sources in Cisco StadiumVision Director

Deployment Guidelines for POS Data Integration and the Widgets Tool for Menu Creation
Table 5 provides a summary of each POS data integration method for menu creation and when to use it
along with information about dependencies and other guidelines. The last row of the table describes use
of a manual method of menu creation where no data integration is used.
Table 5

Deployment Guidelines and Dependencies for POS Data Integration Methods

Data
Integration
Method
Generic PoS

Internal
Database PoS

Menu Theme

None—Manu
al menu
creation in
the Widgets
tool with
static data.

When to Use
•

You need to support POS
data from a vendor other than
Quest or Micros.

•

You only want to use Data
Integration and the Widgets
tool for your menu creation.

•

You have very simple menu
data.

•

You only need your menu
data to appear in a single list.

•

You already use Quest or
Micros POS but want to
build Menu Boards using
Widgets instead of the DMB
application.

•

You already support menus
in DMB using Cisco or POS
stores.

•

You have created menus for
the stores using DMB
themes.

•

You want to support groups
on your menu and use the
Widgets tool to design the
layout of your menu.

•

You have simple menus with
a limited amount of data.

•

You do not have many menus
to maintain.

•

Your menu data does not
change frequently, or, you
have the resources to make
manual menu updates prior
to events.

•

You do not want to use the
DMB application.

DMB
Dependency?
No

Other Dependencies

Guidelines/Best Practices

If you want to categorize
menu items into groups,
then you should have a
data source for each menu
• POS data must conform to
category from the POS
Cisco StadiumVision
vendor.
Director POS API XML
schema.
•

POS vendors host an API
over HTTP/HTTPS for
menu retrieval.

No

Category groupings are not
supported. All menu data is
ingested as one data source.

This is similar to Generic
POS method, except that
you use existing Quest or
Micros installation instead
of a new POS vendor.

Yes

Data changes, such as price
updates, must be made in the
DMB application.

You can use your own
background for the menu
board, or use the theme
background from DMB.

No

Any data changes must be
This method does not use
made manually in the Widgets any data integration
tool.
source.
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Overview of the External Content Integration Interface
The External Content Integration feature is implemented using two basic areas of the Control Panel:
•

Control Panel > Setup > Data Integration
The Data Sources configuration consists of two tabs:
– Configuration—Use to specify the network-related and data parameters for the selected data

source.
– Field mapping—Use to select and map statistics for output display.
•

Control Panel > Widgets
The Widgets tool is used to add graphics and design the layout for the data that you want to display
from the External Content Integration feature.

The remainder of the tasks associated with publishing external content to a TV display use the existing
Cisco StadiumVision Director playlist and script creation interfaces.
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Configuring External Content Integration in
Cisco StadiumVision Director
First Published: April 21, 2014
Revised: October 20, 2014

This module describes the requirements and how to configure support for external data sources in Cisco
StadiumVision Director.
This module includes the following topics:
•

Before You Begin, page 13

•

Workflow Summary for External Content Integration, page 20

•

How to Configure External Content Integration, page 23

Before You Begin
Before you configure Cisco StadiumVision Director for External Content Integration, be sure that the
following requirements are met for the system that you are integrating with:
•

Prerequisites for Configuring NFL GSIS Integration, page 14

•

Prerequisites for Configuring OES ISC9000 Scoreboard Integration, page 14

•

Prerequisites for Configuring Daktronics All Sport 5000 Scoreboard Integration, page 15

•

Prerequisites for Configuring Generic Data Sources, page 18

•

Prequisites for Configuring POS Data Sources, page 19

•

Prerequisites for Configuring RSS and Atom Data Sources, page 19
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Prerequisites for Configuring NFL GSIS Integration
Before you configure the National Football League (NFL) Game Statistics and Information System
(GSIS) integration, be sure that the following requirements are met:
•

The required Cisco StadiumVision Director server hardware is installed and running Cisco
StadiumVision Release 3.0 or later.

•

The NFL Stats-in-a-Box (SIAB) server is installed at the venue and is connected to the NFL GSIS
database. Advise your network administrator to allow communication between these two servers.

•

The SIAB server is reachable by the Cisco StadiumVision Director server on the Internet Protocol
(IP) network.

•

For support of the NFL GSIS clock, be sure that the following is complete:
– A router in the network is configured for Network Address Translation (NAT) to change the

local broadcast address to the unicast IP address of the Cisco StadiumVision Director server.

Tip

You can verify reachability using the ping command from the Cisco StadiumVision Director
server to the SIAB server.
– You have obtained the UDP port number used by the vendor.

•

The NFL GSIS representative has provided the SIAB IP address and account information, which
will be needed to configure Cisco StadiumVision Director connectivity to the SIAB server.

Prerequisites for Configuring OES ISC9000 Scoreboard Integration
Before you configure the OES ISC9000 Intelligent Scoreboard Controller integration, be sure that the
following requirements are met:
•

The required Cisco StadiumVision Director server hardware is installed and running Cisco
StadiumVision Release 3.0 or later.

•

The OES ISC9000 Scoreboard controller is installed at the venue (preferably in the Cisco
StadiumVision network).

•

The OES ISC9000 Scoreboard controller is reachable by the Cisco StadiumVision Director server
on the Internet Protocol (IP) network.

•

A site administrator or OES equipment vendor has added the Cisco StadiumVision Director server
IP address and UDP port number in the OES controller. However, do not select the checkbox to
enable the UDP port under the Serial Port Configuration (Figure 1).

Note

Be sure to record the UDP port number used in the OES ISC9000 controller so that you can
configure the same port in the network connection information for Cisco StadiumVision
Director.
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Figure 1 shows an example of the interface for the Serial Port Configuration on the OES ISC9000
controller where the Cisco StadiumVision Director server information must be added.
Figure 1

OES ISC9000 Configuration

Prerequisites for Configuring Daktronics All Sport 5000 Scoreboard Integration
Before you configure the Daktronics All Sport 5000 Scoreboard integration, be sure that the following
requirements are met:
•

The required Cisco StadiumVision Director server hardware is installed and running Cisco
StadiumVision Release 3.2.

•

The Daktronics Scoreboard controller is installed at the venue (preferably in the Cisco
StadiumVision network).

•

The Lantronix UDS 1100-POE Device Server is installed on the network.

•

A computer is set up with the Daktronics Scoring and Timing Interface (DSTI) software and has two
serial ports available (or use two USB ports with USB-to-serial adapter cables).

•

Be that you have the UDP port number that is hard-coded in the DSTI configuration file so that you
can configure the same port in the network connection information for Cisco StadiumVision
Director.

•

You have the Daktronics configuration file with the baud rate and port information.

•

You have the IP address of the Cisco StadiumVision Director server.

•

The Daktronics Scoreboard controller is reachable by the Cisco StadiumVision Director server on
the network.
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•

The devices are connected using straight-through DB-25 male to DB-9 female serial cables:
– The scoreboard controller is connected to the DSTI computer.
– The DSTI computer is connected to the Lantronix device serial port.

•

You have completed the following configuration tasks on the Daktronics scoreboard controller,
DSTI computer, and Lantronix devices:
– Configuring the Serial Ports on all Devices, page 16 (required)
– Configuring the Network Connections, page 17 (required)

Configuring the Serial Ports on all Devices
•

Configure the serial COM port on the Daktronics scoreboard controller with the following settings:
– Baud 9600

Note

Use the baud rate in the configuration file provided by Daktronics. For example, it could be
19200.

– Parity None
– Data Bits 8
– Stop Bit 1
•

Configure all serial COM ports on the DSTI computer, and Lantronix device with the following
settings:
– Baud 9600

Note

Be sure that the serial ports on the DSTI computer and Lantronix device have matching baud
rates.

– Parity None
– Data Bits 8
– Stop Bit 1
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Figure 2 shows the serial configuration on the Lantronix device.
Figure 2

Lantronix UDS 1100-POE Serial Settings

Configuring the Network Connections
Be sure that the Lantronix device and the DSTI software is network connections are configured:
•

Using the port information provided in the Daktronics configuration file, configure the Lantronix
device connection settings for the UDP protocol, Daktronics port, and the IP address of the Cisco
StadiumVision Director server as shown in the example in Figure 3.

Figure 3

Lantronix UDS 1100-POE Connection Settings
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•

In the Hostlist settings on the Lantronix device, configure the IP address of the Cisco StadiumVision
Director server and port as shown in the example in Figure 4.

Figure 4

•

Lantronix UDS 1100-POE Hostlist Settings

Configure the DSTI application for the Daktronics controller with the IP address of the Cisco
StadiumVision Director server as shown in the example in Figure 5:

Figure 5

Daktronics All Sport 5000 Configuration

Prerequisites for Configuring Generic Data Sources
Before you configure generic data sources, be sure that the following requirements are met:
•

You know the message type of the data source (TCP, HTTP, UDP, FTP, or Database).

•

You have the corresponding connection information for the specified message type.

•

You have a copy of one unique sector of the XML data from the source feed that can be used as
sample data for the External Content Integration configuration or a sample file that can be uploaded
to Cisco StadiumVision Director.

•

Cisco StadiumVision Director must be able to reach any externally referenced source data (for
example, referenced images) on the network.
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Prequisites for Configuring POS Data Sources
Cisco StadiumVision Director supports the following types of POS data sources: Generic PoS, Internal
Database PoS, and Menu Theme. Before you configure a POS data source, be sure that you understand
the differences between these types and when to use them by seeing the “Information About POS Data
Sources in Cisco StadiumVision Director” section on page 10.
This section includes the following topics:
•

Prerequisites for Generic POS Data Sources, page 19

•

Prerequisites for Internal Database POS Data Sources, page 19

•

Prerequisites for Menu Theme POS Data Sources, page 19

Prerequisites for Generic POS Data Sources
Before you configure generic POS data sources, be sure that the following conditions are met:
•

POS vendors host an API over HTTP/HTTPS for menu retrieval, and you have the URL for the
vendor API.

•

POS data must conform to Cisco StadiumVision Director POS API XML schema. You must have
the vendor name and store name for the data source.

•

If you want to categorize menu items into groups, then you should have a data source for each menu
category from the POS vendor.

Prerequisites for Internal Database POS Data Sources
Before you configure internal database POS data sources, be sure that the following requirements are
met:
•

You have an existing Micros or Quest POS configuration in Cisco StadiumVision Director using
stores.

•

You accept that all menu data is ingested as one data source without support for category groupings.

Prerequisites for Menu Theme POS Data Sources
Before you configure menu theme POS data sources, be sure that the following requirements are met:
•

You already support menus in DMB using Cisco or POS stores.

•

You have created menus for the stores using DMB themes.

•

You want to support groups on your menu and use the Widgets tool to design the layout of your
menu.

•

Data changes, such as price updates, must be made in the DMB application.

Prerequisites for Configuring RSS and Atom Data Sources
Before you configure RSS data sources, be sure that the following requirements are met:
•

You have the source URL for the data feed.
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Workflow Summary for External Content Integration
Note

This workflow assumes that you have completed the required backend network installation and
integration at your venue for the external data sources that you plan to support, such as with the NFL
GSIS network and Stats-in-a-Box (SIAB) server, or scoreboard device.
The following steps summarize the overall workflow to integrate data into Cisco StadiumVision Director
and display that content on a TV:
Control Panel Setup Interface—Data Integration Tab (Figure 6)
1.

From the Control Panel, access the Data Integration interface.

2.

Add the predefined data source type that you want to configure.

3.

Complete the network settings configuration.

4.

Modify any data configuration options (for example, throttling), as applicable.

5.

Modify the image display width and height, as applicable.

6.

Save the configuration.

7.

Enable the data collection (click Deploy).

Note

Whenever you modify and save or deploy/undeploy the External Content configuration, you
must restart the application in the Management Dashboard. Cisco StadiumVision Director
prompts you to do this, and it can be done at this step or after you finish mapping and formatting
your statistics.

Figure 6

Data Integration Configuration Workflow
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Control Panel Setup Interface—Field Mapping Tab (Figure 7)
8.

Note

9.

Complete the field mapping for the selected data source by selecting the available statistics that you
want to display in Cisco StadiumVision Director.

For generic data sources, you must first provide sample XML data before you can complete the
field mapping.
Format each statistic to set the output field name and any other output criteria as desired. Click Ok.
Save the mapping.

Figure 7

Field Mapping Workflow

Management Dashboard—External Content Integration (Figure 8)
10. Restart the External Content Integration application from the Management Dashboard.
Figure 8

External Content Integration Application in Management Dashboard
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Control Panel Widgets Interface
11. Use the Widgets tool from the Control Panel to design a layout of the statistics that you configured

to add graphics and bind/position data fields, and save the widget (Figure 9). See the “Designing the
Layout of External Content Using the Widgets Tool” module for more information.
Figure 9

Widgets Tool

12. Create a playlist from the Control Panel for the widget that you created. Widgets are categorized in

the “By Type” folder under the “widget” type (Figure 10).

Tip

Click the Refresh icon in Content screen to see the widget in content library.

Figure 10

Widget Types in Content Screen

13. Create an event script to run the playlist.
14. Schedule the script to display the content on a TV just like other pieces of content in Cisco

StadiumVision Director.
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How to Configure External Content Integration
This section includes the following tasks:
•

Accessing the External Content Integration Interface, page 23 (required)

•

Adding a New Data Source, page 23 (required)

•

Configuring the Network Connection to the External Content Source, page 24 (required)

•

Configuring the Data Options, page 34 (optional)

•

Configuring the Image Display Size for Atom and RSS Feeds, page 38 (optional)

•

Providing Sample XML Data for Generic Data Sources, page 39 (required)

•

Selecting Input Statistics and Mapping to Output Fields for Display, page 42 (required)

•

Enabling the Data Source Configuration, page 43 (required)

•

Activating External Content Integration System-Wide From the Management Dashboard, page 44
(as required)

•

Restarting the External Content Integration Application, page 45 (required)

•

Activating External Content Integration System-Wide From the Management Dashboard, page 44
(required)

Accessing the External Content Integration Interface
To access the external content integration interface, complete the following steps:
Step 1

Log into Cisco StadiumVision Director as an administrator.

Step 2

From the main menu, click Control Panel.

Step 3

From the Setup screen, select Data Integration.
The Data Integration screen is displayed in the Data Sources panel view.

Adding a New Data Source
To add a new data source, complete the following steps:
Step 1

From the Data Sources tab view on the Data Integration screen, click the plus (+) icon.
The Create new data source connection dialog box is displayed.

Step 2

In the Data source name box, type a name for the data source that you want to add.

Tip

Specify a name using upper or lowercase alphabetical characters, digits 0–9, hyphen (-), or
underscore (_). Spaces are not supported.

Step 3

Under the Type column, select the data source type that you want to add.

Step 4

(Generic Data Source only) For a Generic Data Source, select the message type from the drop-down box.
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Step 5

Click Create.
The new data source is displayed in Data Sources panel view, and the Configuration panel is displayed.

What To Do Next
Configure the network connection for your data source type. For more information, see the “Configuring
the Network Connection to the External Content Source” section on page 24.

Configuring the Network Connection to the External Content Source
Complete one or more of the following tasks according to the external content sources that your site is
going to use:
•

Configuring the Connection to an Atom or RSS Feed, page 25

•

Configuring the Connection to a Generic Data Source, page 26

•

Configuring the Connection to a Generic POS Data Source, page 28

•

Configuring the Connection to an Internal Database POS Data Source, page 29

•

Configuring the Connection to a Menu Theme POS Data Source, page 30

•

Configuring the Connection to the NFL GSIS SIAB Server, page 31

•

Configuring the Connection to the Scoreboard Controllers, page 34
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Configuring the Connection to an Atom or RSS Feed
To configure the connection to an Atom or RSS feed, complete the following steps:
Step 1

Go to the Configuration screen for the selected Atom Feed or RSS Feed data source.

Step 2

In the Network settings section, specify the URL in the Data source URL address box (Figure 11):
Figure 11

Step 3

RSS Network Configuration

Click Save.
A message box appears asking you to restart the application.

Step 4

If you have completed all of the changes that you want to make on the Configuration tab, restart the
application.
For more information, see the “Restarting the External Content Integration Application” section on
page 45.

What To Do Next
Configure the data options as needed for the Atom or RSS feed data source. For more information, see
the “Configuring Data Options for Atom and RSS Feeds” section on page 35.
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Configuring the Connection to a Generic Data Source
The connection settings for a generic data source type depend on the message type that is configured
when creating the data source. The generic data source can be configured to support one of the following
message types:
•

FTP

•

HTTP (or HTTPS)

•

TCP

•

UDP

To configure the connection to the generic data source, complete the following steps:
Step 1

Go to the Configuration screen for the selected Generic Data Source name.

Step 2

Do one of the following to specify the generic data source location:
To configure the connection using FTP, specify the following information (Figure 12):
Figure 12

Generic Data Source Configuration: FTP

•

Server (IP address)—IP address of the FTP server.

•

Port—FTP port used in Cisco StadiumVision Director for the FTP server connection. The default is
21.

•

Data path—Folder path for the data. The default is “/”.

•

User—Username for the FTP server connection.

•

Password—Password for the user account on the FTP server.

•

Polling frequency—Number (in seconds) that specifies how often to poll data from the source. The
default is 60.

•

File name filter—Fully-qualified file name or file name with an asterisk (*) wildcard.
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To configure the connection using HTTP, specify the following information (Figure 13):
Figure 13

Generic Data Source Configuration: HTTP

•

HTTP URL—Fully qualified HTTP or HTTPS URL to the data source.

•

Polling frequency—Number (in seconds) that specifies how often to poll data from the source. The
default is 60.

To configure the connection using TCP or UDP, specify the following information (Figure 14):
Figure 14

Generic Data Source Configuration: TCP and UDP

•

StadiumVision Director (IP Address)

•

StadiumVision Director port

To configure the connection for a Database, specify the following information (Figure 15):

Note

Only one database type can be deployed at a time.
Figure 15

Generic Data Source Configuration: Database

•

Database—Name of the database. Supported values are: MySQL (default) or SQLServer.

•

Host—IP address of the server where the database is hosted.

•

Port—Server port where the database is hosted. Default is 3306.

•

Schema—Name of the database schema or instance.
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Step 3

•

Username—Name of the user for authentication to access the database.

•

Password—Password for the specified Username for authentication to access the database.

•

Table Name—Name of the table in the database to retrieve data from.

•

Number of Rows to Retrieve (-1 for all)—Number of data rows to be retrieved from the table.

Click Save.
A message box appears asking you to restart the application.

Step 4

If you have completed all of the changes that you want to make on the Configuration tab, restart the
application.
For more information, see the “Restarting the External Content Integration Application” section on
page 45.

What To Do Next
Provide sample XML data for the generic data source. For more information, see the “Providing Sample
XML Data for Generic Data Sources” section on page 39.

Configuring the Connection to a Generic POS Data Source
Use the Generic POS data source under the following conditions:
•

You need to support POS data from a vendor other than Quest or Micros.

•

You only want to use Data Integration and the Widgets tool for your menu creation.

To configure the connection to the generic POS data source, complete the following steps:
Step 1

Go to the Configuration screen for the selected generic POS data source name.

Step 2

Specify the Database Settings (Figure 16):
Figure 16

Step 3

Generic POS—Database Settings

•

Vendor Name (required)—Name of the vendor for the POS data source.

•

Store Name (required).

Specify the Network Settings (Figure 17):
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Figure 17

•

Generic POS—Network Settings

Data source URL address (required)—HTTP or HTTPS URL of the POS vendor API.
If an HTTPS URL is specified, the User Name and Password must be specified for authentication.

Step 4

•

User Name

•

Password

Specify the Polling Interval (required)—Number (in seconds) for the frequency to poll data from the
source feed. Default is 60. (Figure 18):
Figure 18

Step 5

Specify the dimensions to which menu item images are resized (Figure 19):
Figure 19

Step 6

Generic POS—Polling Interval

Generic POS—Image Display Settings

•

Width—Number of horizontal pixels. Default is 600.

•

Height—Number of vertical pixels. Default is 400.

Click Save.
A message box appears asking you to restart the application.

Step 7

If you have completed all of the changes that you want to make on the Configuration tab, restart the
application.
For more information, see the “Restarting the External Content Integration Application” section on
page 45.

Configuring the Connection to an Internal Database POS Data Source
Use the internal database POS data source under the following conditions:
•

You have very simple menu data.

•

You only need your menu data to appear in a single list.

•

You already use Quest or Micros POS but want to build Menu Boards using Widgets instead of the
DMB application.
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To configure the connection to an internal database POS data source, complete the following steps:
Step 1

Go to the Configuration screen for the selected internal database POS data source name.

Step 2

Specify the Database Settings (Figure 20):
Figure 20

Step 3

•

Vendor Name (required)—Name of the existing DMB vendor already integrated with Cisco
StadiumVision Director to be the POS data source. Possible values are Micros or Quest.

•

Store Name (required)—Name of the store configured in the DMB application for the vendor.

Specify the Polling Interval (required)—Number (in seconds) for the frequency to poll data from the
source feed. Default is 60. (Figure 21):
Figure 21

Step 4

Internal Database POS—Database Settings

Internal Database POS—Polling Interval

Click Save.
A message box appears asking you to restart the application.

Step 5

If you have completed all of the changes that you want to make on the Configuration tab, restart the
application.
For more information, see the “Restarting the External Content Integration Application” section on
page 45.

Configuring the Connection to a Menu Theme POS Data Source
Use the Menu Theme POS data source under the following conditions:
•

You already support menus in DMB using Cisco or POS stores.

•

You have created menus for the stores using DMB themes.

•

You want to support groups on your menu and use the Widgets tool to design the layout of your
menu.

To configure the connection to a menu theme POS data source, complete the following steps:
Step 1

Go to the Configuration screen for the selected menu theme POS data source name.

Step 2

Under Database Settings, specify the Theme Name (required) (Figure 22):
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Note

This Theme Name must match the name configured in the DMB application.
Figure 22

Step 3

Specify the Polling Interval (required)—Number (in seconds) for the frequency to poll data from the
DMB application. Default is 60. (Figure 23):
Figure 23

Step 4

Menu Theme POS—Database Settings

Internal Database POS—Polling Interval

Click Save.
A message box appears asking you to restart the application.

Step 5

If you have completed all of the changes that you want to make on the Configuration tab, restart the
application.
For more information, see the “Restarting the External Content Integration Application” section on
page 45.

Configuring the Connection to the NFL GSIS SIAB Server
This section includes the following topics:
•

Configuring the Network Settings for NFL Cumulative Statistics, page 31

•

Configuring the UDP Connection for the NFL Game Clock, page 32

Configuring the Network Settings for NFL Cumulative Statistics

Note

Before you configure the FTP connection, be sure that you have the IP address and account credentials
for the SIAB server from your NFL GSIS representative.
Cisco StadiumVision Director uses FTP port 21 to communicate with the NFL GSIS SIAB server to
obtain the GSIS statistics.
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To configure the network connection to the NFL GSIS SIAB server, complete the following steps:
Step 1

Go to the Configuration screen for the selected GSIS: NFL,Cumulative Statistics data source.

Step 2

In the Network settings section, configure the following options (Figure 24):
a.

In the Server (IP Address) box, type the IP address of the SIAB server.

b.

In the Port box, type 21. The default is 21.

c.

In the Data path box, type “/”. The default is /.

d.

In the User box, type the username for the SIAB server account. The default is nfl.

e.

In the Password box, type the password for the SIAB server account. The default is nfl.

Figure 24

Step 3

NFL Cumulative Statistics Network Configuration

Click Save.
A message box appears asking you to restart the application.

Step 4

If you have completed all of the changes that you want to make on the Configuration tab, restart the
application.
For more information, see the “Restarting the External Content Integration Application” section on
page 45.

What To Do Next

Configure the data options for the NFL Cumulative Statistics data source. For more information, see the
“Configuring Data Options for NFL Cumulative Statistics” section on page 37.

Configuring the UDP Connection for the NFL Game Clock

Note

Be sure that you know the UDP port number to communicate with the NFL GSIS SIAB server to obtain
the GSIS game clock.
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To configure the UDP connection for the NFL game clock, complete the following steps:
Step 1

Go to the Configuration screen for the selected GSIS: NFL,Clock data source.

Step 2

In the Network settings section, configure the following options (Figure 25):
a.

Tip

b.

In the StadiumVision Director (IP Address) box, type the IP address of the Cisco StadiumVision
server.

The actual IP address of the Cisco StadiumVision server that you are logged into is provided in
shadow, but you must type the address in the box to configure it.
In the StadiumVision Director port box, type the port number being used by the GSIS server. The
default is 0.

Figure 25

Step 3

NFL Game Clock Network Configuration

Click Save.
A message box appears asking you to restart the application.

Step 4

If you have completed all of the changes that you want to make on the Configuration tab, restart the
application.
For more information, see the “Restarting the External Content Integration Application” section on
page 45.

What To Do Next

Configure the data options for the NFL Clock data source. For more information, see the “Configuring
the Incoming Data Filter Rate for Data Sources” section on page 38.

Cisco StadiumVision Director External Content Integration Guide

33

Configuring External Content Integration in Cisco StadiumVision Director
How to Configure External Content Integration

Configuring the Connection to the Scoreboard Controllers
Cisco StadiumVision Director uses a UDP port to communicate to the controllers to obtain the
scoreboard statistics.

Note

Be sure that you know the UDP port being used for your scoreboard controller.
To configure the UDP connection to the scoreboard controllers, complete the following steps:

Step 1

Go to the Configuration screen for the selected scoreboard data source.

Step 2

In the Network settings section, configure the following option (Figure 26):
In the StadiumVision Director port box, type the UDP port number used to connect to the scoreboard
controller.
Figure 26

Step 3

Daktronics Scoreboard Controller Network Configuration

Click Save.
A message box appears asking you to restart the application.

Step 4

If you have completed all of the changes that you want to make on the Configuration tab, restart the
application.
For more information, see the “Restarting the External Content Integration Application” section on
page 45.

What To Do Next
Configure the data options for the scoreboard data source. For more information, see the “Configuring
the Incoming Data Filter Rate for Data Sources” section on page 38.

Configuring the Data Options
The data configuration options vary by the data source type:
•

Configuring Data Options for Atom and RSS Feeds, page 35

•

Configuring Data Options for Generic Database Sources, page 35
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•

Configuring Data Options for NFL Cumulative Statistics, page 37

•

Configuring the Incoming Data Filter Rate for Data Sources, page 38

Configuring Data Options for Atom and RSS Feeds
To configure data options for Atom and RSS feeds, complete the following steps:
Step 1

Go to the Configuration screen for the selected Atom Feed or RSS Feed data source.

Step 2

In the Data configuration section, set one or more of the following options (Figure 27):
Figure 27

a.

Data Configuration Options for Atom and RSS Feeds

Number of messages keep—Number of messages to keep from the feed. The default is 5.

Tip

If planning to use images from the feed for the PicToScreen component in the Widgets tool, then
a maximum of 5 images can be displayed. It is recommended that the number of messages to
keep is 5 for images.

b.

Data polling interval—Number (in seconds) for the frequency to poll data from the source feed. The
default is 60.

Tip

60 seconds is the recommended polling interval for images. Consider a longer interval for text
feeds.

c.

Cache period—Amount of time (in minutes) to retain polled data. The default is 30.

What To Do Next
Configure the image size as needed for the Atom or RSS feed data source. For more information, see the
“Configuring the Image Display Size for Atom and RSS Feeds” section on page 38.

Configuring Data Options for Generic Database Sources
To configure data options for generic database sources, complete the following steps:
Step 1

Go to the Configuration screen for the selected generic database data source.

Step 2

In the Data polling, filtering, and throttling section, set one or more of the following options (Figure 28):

Cisco StadiumVision Director External Content Integration Guide

35

Configuring External Content Integration in Cisco StadiumVision Director
How to Configure External Content Integration

Figure 28

Step 3

Data Configuration Options for Generic Database Sources

a.

Polling interval—Number (in seconds) for the frequency to poll data from the source feed. The
default is 60.

b.

Incoming data filter rate—Number (in seconds) that specifies the amount of time to ignore duplicate
data and process only new data. The default is 20.

Click Save.
A message box appears asking you to restart the application.

Step 4

If you have completed all of the changes that you want to make on the Configuration tab, restart the
application.
For more information, see the “Restarting the External Content Integration Application” section on
page 45.

What To Do Next
Enable the data source. For more information, see the “Enabling the Data Source Configuration” section
on page 43.
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Configuring Data Options for NFL Cumulative Statistics
To configure data options for NFL cumulative statistics, complete the following steps:
Step 1

Go to the Configuration screen for the selected GSIS: NFL, Cumulative Statistics data source.

Step 2

In the Data polling, filtering, and throttling section, set one or more of the following options (Figure 29):
Figure 29

Step 3

NFL Cumulative Statistics Data Configuration Options

•

File name—Name of the cumulative statistics file on the SIAB server. The default is
GSISGameStats.xml.

•

Wait to read data from source (FTP polling interval)—Number (in milliseconds) that specifies how
often to retrieve data from the SIAB server. The default is 60.

Click Save.
A message box appears asking you to restart the application.

Step 4

If you have completed all of the changes that you want to make on the Configuration tab, restart the
application.
For more information, see the “Restarting the External Content Integration Application” section on
page 45.

What To Do Next
Enable the data source. For more information, see the “Enabling the Data Source Configuration” section
on page 43.
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Configuring the Incoming Data Filter Rate for Data Sources
Note

This data option is available for GSIS NFL clock, Daktronics, OES scoreboard, and Generic database
data sources.
To configure the incoming data filter rate for data sources, complete the following steps:

Step 1

Go to the Configuration screen for the selected NFL clock or scoreboard controller data source.

Step 2

In the Incoming data filter rate box, specify the number (in seconds) that specifies the amount of time to
ignore duplicate data and process only new data (Figure 30). The default is 20.
Figure 30

Step 3

Incoming Data Filter Rate Option

Click Save.
A message box appears asking you to restart the application.

Step 4

If you have completed all of the changes that you want to make on the Configuration tab, restart the
application.
For more information, see the “Restarting the External Content Integration Application” section on
page 45.

What To Do Next
Enable the data source. For more information, see the “Enabling the Data Source Configuration” section
on page 43.

Configuring the Image Display Size for Atom and RSS Feeds
Image dimensions are retained from the original source unless you change the image display size options
from the default values of width 0 and height 0. If you specify the image width and height, then the
source images from that data feed will be resized.
To configure the image display size, complete the following steps:
Step 1

Go to the Configuration screen for the selected data source type.

Step 2

In the Image display section, set one or more of the following options using the spinner control:
a.

In the Width box, select the horizontal dimension of the image (in pixels).

b.

In the Height box, select the vertical dimension of the image (in pixels).
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Step 3

Click Save.
A message box appears asking you to restart the application.

Step 4

If you have completed all of the changes that you want to make on the Configuration tab, restart the
application.
For more information, see the “Restarting the External Content Integration Application” section on
page 45.

What To Do Next
Select the input statistics that you want to map for output display. For more information, see the
“Selecting Input Statistics and Mapping to Output Fields for Display” section on page 42.

Providing Sample XML Data for Generic Data Sources
Note

This task is only required when you are configuring a Generic Data Source.
The sample XML data is used to “train” the system on the content to be expected from the configured
generic data source. You can provide sample XML data for generic data sources in two ways:
•

Uploading a sample XML file (Recommended).

•

Pasting a sample of the XML data.

Prerequisites
Before you begin this task, be sure that the following requirements are met:
•

You have obtained a sample of your XML data, or you have a file available to be uploaded to Cisco
StadiumVision Director.

•

If you are going to paste sample data in the Field Mapping screen, be sure that you have groomed
the sample to remove any repeating elements. This will help streamline the processing and avoid
reaching limits on the size of the file that can be used in the Data Integration interface.

Recommended Procedure
To upload a sample XML file for generic data sources, complete the following steps:
Step 1

Go to the Field Mapping screen for the selected generic data source.

Step 2

To upload a sample XML file, complete the following steps:
a.

Click the upload arrow icon (Figure 31).
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Figure 31

Upload Sample XML File for Generic Data Source Field Mapping

b.

In the Open dialog box, go to the location of your XML sample file and select it.

c.

Click Open.
The data fields from the XML file are listed in the Input field box (Figure 32). You can click the
arrows to verify the available input fields and sample data that were uploaded.

Figure 32

d.

Sample XML File Input Fields

Click Save.

Alternate Procedure
To provide sample XML data for generic data sources, complete the following steps:
Step 1

Go to the Field Mapping screen for the selected generic data source.

Step 2

To manually provide sample XML data, click the pencil icon (Figure 33).
Figure 33

Update Sample Data for Generic Data Source Field Mapping
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Step 3

In the Sample data panel, paste the representative XML code from your sample file and click the Save
icon.
Figure 34 shows an excerpt of XML code from a source for BATS Exchange data.
Figure 34

Paste XML into Sample Data Panel

The input fields with sample data from the saved XML source that you pasted are shown in the Field
Mapping screen. You can expand the fields to show more data elements (Figure 35).
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Figure 35

Paste XML into Sample Data Panel

What To Do Next
Select the input statistics that you want to map for output display. For more information, see the
“Selecting Input Statistics and Mapping to Output Fields for Display” section on page 42.

Selecting Input Statistics and Mapping to Output Fields for Display
To select input statistics and map to output fields for display, complete the following steps:
Step 1

Go to the Field Mapping screen for the selected data source.

Step 2

To view the available statistics, click the arrow beside the data file name to expand the list.
The Sample Data column displays a representative value for each statistic.

Step 3

With your mouse, select a statistic and drag-and-drop it to the Output Fields panel on the right.

The Add Output field dialog box is displayed.
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Step 4

Modify the Output field name or other mapping options as needed.
For more information, see the “Modifying the Output Format of a Statistic” section on page 55.

Step 5

Continue to select and add statistics to the Output fields panel.

Step 6

Click Save.

What To Do Next
Enable the data source. For more information, see the “Enabling the Data Source Configuration” section
on page 43.

Enabling the Data Source Configuration
By default, external data collection and configuration is disabled. Once you have completed your
configuration, you must both enable the data source and save the configuration to allow collection of the
data.
Disabled data sources are indicated by a gray checkmark in the Enabled column of the corresponding
data source name. When a data source is enabled, the checkmark turns green.

Note

Real-time data collection from the SIAB server will not begin until the External Content Integration
application has been both enabled and restarted in Cisco StadiumVision Director. For more information,
see the “Activating External Content Integration System-Wide From the Management Dashboard”
section on page 44 and “Restarting the External Content Integration Application” section on page 45.
To enable the data source configuration, complete the following steps:

Step 1

In the left pane, select the data source.

Step 2

Click Deploy.
A message box appears asking you to restart the application.
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Step 3

If you have completed all of the changes that you want to make on the Configuration tab, restart the
application.
For more information, see the “Restarting the External Content Integration Application” section on
page 45.

Note

To disable a data source configuration, repeat this task but click Undeploy at Step 2.

Activating External Content Integration System-Wide From the Management
Dashboard
By default, External Content Integration is enabled system-wide in Cisco StadiumVision Director. After
you have saved and enabled your data source configuration, you must restart the application from the
Management Dashboard before data collection can begin.
If you have disabled the External Content Integration application, then it must only be activated once to
deploy it in the Cisco StadiumVision Director server. Once the External Content Integration application
has been activated in the system, then any time the configuration has been changed, the application only
must be restarted.
To activate External Content Integration system-wide, complete the following steps:
Step 1

Log into Cisco StadiumVision Director as an administrator.

Step 2

From the Cisco StadiumVision Director main menu, click Management Dashboard.

Step 3

Using the Management Dashboard drawers, go to Tools > Settings > External Content Integration.

Step 4

Select Activate Application.

Step 5

Click the Play button.

Step 6

When the confirmation message box appears, click Ok to run the command.
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Step 7

To verify the application activation, look for the success message in the log display area of the screen.

Step 8

After the processing has completed, select Restart Application.
For more information, see the “Restarting the External Content Integration Application” section on
page 45.

Restarting the External Content Integration Application
Any time that you have made a change to the External Content Integration settings on the Configuration
tab for external data sources, you must restart the application from the Cisco StadiumVision Director
Management Dashboard.
When you save the configuration, a message is displayed as a reminder to restart:

Note

Changes to the data source field mapping only need to be saved, but the application does not have to be
restarted. However, if for some reason you did not do a restart of the application after making changes
in the Configuration tab before going on to save changes in Field mapping, then you also will see this
message about the required restart at the time you save the Field mapping.
To restart the External Content Integration Application, complete the following steps:

Step 1

Log into Cisco StadiumVision Director as an administrator.

Step 2

From the Cisco StadiumVision Director main menu, click Management Dashboard.

Step 3

Using the Management Dashboard drawers, go to Tools > Settings > External Content Integration.

Step 4

Select Restart Application.

Step 5

Click the Play button to run the command.

Step 6

When the confirmation message box appears, click Ok to run the command.

Cisco StadiumVision Director External Content Integration Guide

45

Configuring External Content Integration in Cisco StadiumVision Director
How to Configure External Content Integration

Step 7

To verify the application activation, look for the success message in the log display area of the screen.

Verifying the Integration
This section includes the following topics:
•

Verifying Receipt of Real-Time Data, page 46

•

Verifying the Integration Broker Service Status, page 47

Verifying Receipt of Real-Time Data
Assuming that your network connection to the external data source is available and you have enabled the
data source, real-time data is collected after you both activate and restart the application in the
Management Dashboard.
To verify the receipt of real-time data, complete the following steps:
Step 1

From the Data Integration interface, select the data source that you want to verify.

Step 2

Click Field mapping.

Step 3

In the Output field panel, select the link in the Data preview column.
Figure 36 shows selection of a Mozes RSS feed with two image items available for data preview from
the active feed.
Figure 36

Data Preview Example

After you click the link, a Preview window opens displaying the live data from your feed.
Figure 37 shows an example of the images along with their corresponding URLs that are displayed in
the preview window.

Tip

Use the scroll bar to see all of the available preview data.
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Figure 37

Step 4

Image Preview of Active RSS Feed

Click x to close the window.

Verifying the Integration Broker Service Status
To verify the integration broker service status, complete the following steps:
Step 1

From the Management Dashboard, go to the Service Alerts pane in the bottom right corner.

Step 2

Navigate to find the Integration Broker service name and observe its status icon.

When the icon is green, the External Content Integration service is successfully activated.
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This module describes some of the optional and advanced tasks that you can perform for External
Content Integration in Cisco StadiumVision Director.
This module includes the following topics:
•

Working with Data Views, page 49

•

Modifying the Output Format of a Statistic, page 55

•

Modifying the Default Data Throttling Values and Registry Configuration, page 58

•

Disabling the Data Source Configuration, page 60

•

Deactivating the External Content Integration Application From the Management Dashboard,
page 60

Working with Data Views
This section describes how to select and merge content from multiple data sources into a single data view
for ingestion into Cisco StadiumVision Director and prepare the content for presentation.

Prerequisites
Before you create a data view, be sure that the following requirements are met:
•

The data sources whose content elements you want to combine into a data view are added and
configured. For more information, see the “Configuring External Content Integration in
Cisco StadiumVision Director” module on page 13.

•

If you want to select specific elements of the data feed, use the Expression Editor to filter the
elements that you want to include or exclude. For more information, see the “Modifying the Default
XPath Expression” section on page 57.

Cisco StadiumVision Director External Content Integration Guide

49

Configuring Optional and Advanced Tasks for External Content Integration
Working with Data Views

Task List
This section includes the following tasks:
•

Creating a Data View, page 50 (required)

•

Adding Data Sources to the Data View, page 51 (required)

•

Enabling the Data View, page 53 (required)

•

Configuring the Data View as a New Data Source, page 54 (required)

Creating a Data View
To create a data view, complete the following steps:
Step 1

From the Control Panel > Setup screen, click Data Integration.
The Data Integration screen is displayed in the Data Sources panel view.

Step 2

Click Advanced.

Step 3

To create a new data view, click +Add in the Advanced panel.
The New data view dialog box is displayed (Figure 1).
Figure 1

Step 4

New data view Dialog Box

In the Data view name box, type the name of the view that you want to create.
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Step 5

Click Create.
The new data view is added to the list of Data view names (Figure 2).
Figure 2

New data view Panel

Adding Data Sources to the Data View
Any data source type can be added to a data view.
To add data sources to the data view, complete the following steps:
Step 1

To add a data source and its configured fields to the selected data view, click the plus (+) icon in the Data
fields panel (Figure 3).
Figure 3

Add Data Source Fields
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A list of the available configured data sources is displayed in the Add or select data source panel
(Figure 4).

Tip

The example shows generic data sources, but any data source type can be added to a data view.
Figure 4

Step 2

Add or select data source Panel

To add a data source to the data view, select a source name from the list and click <<. Repeat this step
for as many data sources as you want to combine in the data view.

Note

Multi-selection of data sources is not supported.

The sources that you added are displayed under the Data source column (Figure 5).
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Figure 5

Data Sources Selected in Data View

Step 3

After you have added all required data sources, click Done.

Step 4

Click Save.

Enabling the Data View
Disabled data views are indicated by a gray checkmark in the Enabled column of the corresponding data
view name. When a data view is enabled, the checkmark turns green.
To enable the data view, complete the following steps:
Step 1

To enable the data view, select the data view name and click the checkmark icon (Figure 6).
Figure 6

Step 2

Enable Data View

Click Save.
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Configuring the Data View as a New Data Source
After you create a data view, you must configure it as a new data source to make the data available to the
External Content Integration feature.

Prerequisites
Before you configure the data view as a new data source, be sure that the following requirements are met:
•

You have the internal URL that identifies the location of the view. The format of the URL is shown
in the following example, where svd-ip-address is the IP address of the Cisco StadiumVision
Director server and dataview-name is the name of the data view that you created:
http://svd-ip-address:8888/StadiumVision/flows/dataview/data/dataview-name
In our example, the following URL would be used:
http://10.10.10.10:8888/StadiumVision/flows/dataview/data/My_Data_View

•

Tip

You have sample XML data for the combined data sources.

You can use the data view URL to get the sample XML data.

Procedure
To configure the data view as a new data source, complete the following steps:
Step 1

From the Data Integration screen, click Data Sources.

Step 2

Add a new Generic Data Source with the HTTP message type.

Step 3

Type the internal URL to the configured data view (Figure 7).
Figure 7

Step 4

HTTP URL for Data View

Click Field Mapping.
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Step 5

Provide the sample XML data.
For more information, see the “Providing Sample XML Data for Generic Data Sources” section on
page 39.

Step 6

Select the input fields and map them for display.
Fore more information, see the “Selecting Input Statistics and Mapping to Output Fields for Display”
section on page 42.

Step 7

Enable the data source.
For more information, see the “Enabling the Data Source Configuration” section on page 43.

Step 8

Verify the data integration.
For more information, see the “Verifying the Integration” section on page 46.

What To Do Next
After you have defined, enabled and verified your data view as new data source, go to the Widgets tool
to layout the content. For more information, see the “Designing the Layout of External Content Using
the Widgets Tool” module on page 61.

Modifying the Output Format of a Statistic
You can use the default format and value of a mapped statistic for output using the default “Pass through
input field” option, or you can modify its characteristics for display.
The following types of actions can be taken on input field data:
•

Changing the Output Field Name, page 56

•

Adding a Prefix or Suffix String to a Field, page 56

•

Looking Up Content, page 57

•

Modifying the Default XPath Expression, page 57
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This editing can be done either when you first add a statistic to the Output fields panel (in the Add Output
field dialog box), or later if you edit the statistic from the Output fields panel (in the Edit Output field
dialog box) as shown in Figure 8.
Figure 8

Change Output Field Dialog Box

Changing the Output Field Name
To change the output field name, complete the following steps:
Step 1

In the Output field name box of the Change Output field dialog box, type the new name of the field that
you want to use.

Step 2

Click Ok.

Adding a Prefix or Suffix String to a Field
You can add a character string as a prefix or suffix to the input field value. For example, if the default
input value for an input field called Period1 was a numeric value “1,” you could specify “st” in the suffix
box so that the input field value is appended with this string and appears in the output as “1st.”
To add a prefix or suffix string to an input field, complete the following steps:
Step 1

In the Mapping section of the Change Output field dialog box, select the Add option.

Step 2

Do one of the following:

Step 3

•

To add a character string as a prefix to the input field value, type the string in the Prefix box.

•

To add a character string as a suffix to the input field value, type the string in Suffix box.

Click Ok.
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Looking Up Content
You can find an image from the content library to display in the widget. An image can be located using
the image name (such as “Image1.png”), either as part of the value of the input field or as an explicit
reference in the text box. If you are locating the image as part of the input field, be sure to select the
“Lookup by input field reference” checkbox.
To look up content, complete the following steps:
Step 1

In the Mapping section of the Change Output field dialog box, select the Content lookup option.

Step 2

Do one of the following:

Step 3

•

To specify the explicit filename, either type the filename in the Lookup key box or click Select to
browse for it.

•

Click the “Lookup by input field reference” checkbox if you want the image to be located as part of
the input field data.

Click Ok.

Modifying the Default XPath Expression
Currently, the two functions supported in the External Content Integration feature are “lookup” and
“concat.”

Tip

For information about XPath expressions, see the following URL:
http://www.w3schools.com/xpath/default.asp
To modify the default XPath expression, complete the following steps:

Step 1

In the Mapping section of the Change Output field dialog box, select the Expression option.

Step 2

Click Expression Editor.
The Expression Editor dialog box is displayed.

Step 3

In the text editor box where the expression for the input field function is displayed, modify the
expression using standard XPath expression syntax.

Step 4

Click Ok.

Choosing Specific Items From a Feed
Use the position() XPath predicate to include or exclude specific items from a given feed.
The following expression shows the default syntax for an RSS feed using the title element:
/rss/channel/item/title/text()
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Example 1

To modify this expression to select only the third and fourth data elements from the feed, modify the
expression to add the following position predicate:
/rss/channel/item[position()>2 and position()<5]/title/text()

Example 2

To modify the expression to include the second, third and fourth data elements from the feed, use the
following position predicate:
/rss/channel/item[position()>=2 and position()<5]/title/text()

Modifying the Default Data Throttling Values and Registry
Configuration
Beginning in Cisco StadiumVision Director Release 3.1, certain data throttling values for External
Content Integration that were configurable within the Cisco StadiumVision Director Release 3.0 user
interface per data source were changed to be configurable as registry keys in the Management Dashboard
that now apply globally to all configured data sources.

Note

The default values and units of measure (from seconds to milliseconds) for these registry keys were
changed in Cisco StadiumVison Director Release 3.1 SP1. However, if you have modified these values
from the original default values prior to upgrade, then the new default values will not be applied.
However, be aware that the units of measure will be changed to milliseconds so be sure that you manually
convert your original value from seconds to milliseconds.

Caution

Configuration of data throttling can be required to maintain optimum DMP performance to support
External Content Integration in Cisco StadiumVision Director. Be sure that if you plan to modify the data
throttling values, you understand that DMP performance could be severely impacted, and that you make
changes only when no events are running in the venue and during an adequate maintenance window for
the system.
The actual performance impact is dependent on a combination of factors including the registry values
that are set, the number of data sources, and the amount of content / widgets / datasources visible on the
DMP display.
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Table 1 describes the global registry keys that apply to all data sources configured for External Content
Integration beginning in Cisco StadiumVision Director Release 3.1.
Table 1

Registry Key

External Content Integration Data Throttling Registry Keys

New Default
(Release 3.1 SP1
and Later)

databind.minUpdateInterval 500 ms
(.5 seconds)

Old Default
(Release 3.1)
10 seconds

Description
Specifies the amount of time to wait since the last update
before sending a multicast of new data from the External
Content Integration service to all DMPs.
Modify this registry key value to tune the display of
clock values in Cisco StadiumVision Director (when
they are inaccurate to the second), by lowering the
default number of milliseconds.

databind.maxUpdateInterval 60000 ms
(60 seconds)

60 seconds

Note

This global registry key corresponds to the
original “Wait to push data to destination” data
throttling option in Cisco StadiumVision
Director Release 3.0, but the option can no
longer be set per data source and applies to all
configured data sources.

Tip

This control is different than the “Incoming data
filter rate” data throttling option that specifies
the amount of time to process only new data
from the data source to the External Content
Integration service.

Specifies the longest amount of time to wait before
sending the multicast of any unchanged data to all
DMPs.
For data sources that support setting of polling intervals,
the practical lower limit for this registry key corresponds
to that polling interval. The interval cannot be set lower
than 1000 ms.
Note

This global registry key corresponds to the
original “Push data if wait exceeds” data
throttling option in Cisco StadiumVision
Director Release 3.0, but the option can no
longer be set per data source and applies to all
configured data sources.
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Disabling the Data Source Configuration
To disable the data source configuration, complete the following steps:
Step 1

In the left pane, select the data source.

Step 2

Click Undeploy.
A message box appears asking you to restart the application.

Step 3

If you have completed all of the changes that you want to make on the Configuration tab, restart the
application.
For more information, see the “Restarting the External Content Integration Application” section on
page 45.

Deactivating the External Content Integration Application From
the Management Dashboard
By default, the External Content Integration Application is activated in Cisco StadiumVision Director.
If your site is not going to connect to any external servers, then you can deactivate it to disable the
functionality of the application system-wide in Cisco StadiumVision Director.
To deactivate the External Content Integration application, complete the following steps:
Step 1

Log into Cisco StadiumVision Director as an administrator.

Step 2

From the Cisco StadiumVision Director main menu, click Management Dashboard.

Step 3

Using the Management Dashboard drawers, go to Tools > Settings > External Content Integration.

Step 4

Select Deactivate Application.

Step 5

Click the Play button to run the command.

Step 6

When the confirmation message box appears, click Ok to run the command.

Step 7

After the processing has completed, select Restart Application and click the Play button.

Step 8

When the confirmation message box appears, click Ok to run the command.
The deactivation of the application will be completed.
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Designing the Layout of External Content Using
the Widgets Tool
First Published: April 21, 2014
Revised: October 16, 2014

This module describes how to design the layout for display of the data that you have integrated and
mapped for output in Cisco StadiumVision Director using the External Content Integration feature. This
layout is required to create a content object referred to as a widget, that you can then publish with the
standard features of Cisco StadiumVision Director using playlists and scripts for eventual display on
TVs.
This module includes the following topics:
•

Prerequisites for Using the Widgets Tool, page 61

•

Restrictions for Using the Widgets Tool, page 62

•

Information About Using the Widgets Tool, page 62

•

How to Design the Layout of External Content for Display, page 74

•

Configuration Examples, page 85

•

What to Do Next, page 115

Prerequisites for Using the Widgets Tool
Before you design the layout of external content, be sure that the following requirements are met:
•

You have configured the external data sources and mapped the statistics to output fields in the
External Content Integration feature.

•

The data from the external source is being properly ingested by Cisco StadiumVision Director.

•

You have added any standalone graphics that you want to add to the layout by importing them into
Cisco StadiumVision Director from Control Panel > Content > Import.
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Restrictions for Using the Widgets Tool
Before you design the layout of external content using the Widgets tool, consider the following
restrictions:
•

The Widgets layout tool can only be used for data sources that have been integrated into Cisco
StadiumVision Director using the External Content Integration feature.

•

Cisco StadiumVision Director only supports widgets that are created internally using the Widgets
tool.

•

Up to16 different sessions can be supported in the Widgets tool on a single computer.

•

The maximum graphic size supported is 1920x1080, which is also the maximum size of the area
supported in the Widgets layout tool.

Note
•

If you attempt to use a larger graphic in the Widgets tool, it might not be displayed.
The PicToScreen component has the following restrictions:
– A maximum of 5 images can be rotated using the PicToScreen component. Therefore, up to the

first 5 images received from the data feed can be displayed. A new set of images can be retrieved
at the next polling interval.
– Supports binding of image data fields only from a source feed. Therefore, the data source must

be defined with an image field for output display. For more information on field mapping in the
data source, see the “Selecting Input Statistics and Mapping to Output Fields for Display”
section on page 42.
•

The TextToScreen component supports binding of text data fields from a source feed. Therefore, the
data source must be defined with a title, description, or other text data field for output display.

•

The Widgets tool has the following font restrictions:
– Only the Arial font type with the ASCII character set is supported.

Note

While you might be able to see a supported localized language and create text components with
non-ASCII characters in the Widgets tool, these text components might not be rendered as
expected on the DMP.
– The maximum font size is limited to 128 due to a restriction by the DMP.
– Importing of fonts is not supported.

•

The following functions are not supported in the Widgets tool:
– Undo
– Deleting a group of multi-selected components

Information About Using the Widgets Tool
This section includes the following topics:
•

Components, page 63

•

Layers, page 66
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•

Properties and Effects, page 67

•

Data Binding and Preview, page 73

•

User Interface Characteristics, page 74

Components
The Widgets tool includes image-based and text-based components, and a tabular list component. There
is also a special Data Pull component for certain environments where a change in the way data is
retrieved and processed by Cisco StadiumVision Director is needed.
New components are added to the widget area simply by dragging the object type and dropping it onto
the canvas or by double-clicking the component.
The Widgets tool includes the following components:
•

Standalone Text and Graphic Components, page 63

•

Data Feed Components, page 63

•

List Component, page 65

•

Data Pull Component, page 66

Standalone Text and Graphic Components
Two component types are intended for data with standalone text or graphics:
•

Text Area

•

Graphic
The Widgets tool uses the Graphic component to support the addition of standalone images. Each
time a graphic component is added to a widget, it is added in numerical order as a Layer on the
canvas.

Data Feed Components
Cisco StadiumVision Director Release 3.1 introduced two new component types to support generic data
sources and feeds, whose content is either image-based or text-based.

P2S (PicToScreen)
The PicToScreen component supports only image data fields from the data source, and can display up to
5 images from a data feed. The images appear in a fixed overlapping cascade that rotates through the
available images from the feed (Figure 1).

Note

The cascading layout of the images cannot be changed. However, you can alter the position and
orientation of the top graphic within the Widgets tool.
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Figure 1

Example of PicToScreen Widget Display of 5 Maximum Images

Default Images and Display Behavior

Cisco StadiumVision Director has default images that are used as placeholders for any images that
cannot be found or when the number of images received does not equal the number defined in the
“Images to Display” property of the PicToScreen component (up to 5).
If Cisco StadiumVision Director must insert default images when enough images are not received from
the data feed, then only the good images from the data feed are rotated through the cascading
presentation. The default images will remain at the back of the stack in the presentation.
The default image is called DefaultImg.jpg and is found in the content library. You can change the
default image by uploading your own image into the content library and change the “ContentName”
property in the P2S component.
Image Orientation

You can change the position and rotation of the top graphic in the PicToScreen component. However,
you cannot control the position or rotation of individual images within the stack.

T2S (TextToScreen)
The TextToScreen component can support any number of messages from the data feed.
Figure 3 shows an example of a fixed background graphic component, with a TextToScreen component
overlay in Figure 3.
Figure 2

Example of TextToScreen Widget Background Graphic
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Figure 3

Example of TextToScreen Widget Display

List Component
Cisco StadiumVision Director Release 3.2 introduces the List component, whose content is either
image-based or text-based.
The List component can be used to create tables by grouping individual list components side-by-side
either vertically or horizontally. The default format for the List component is a horizontal row of two
cells. By changing the orientation to a vertical layout, the component becomes a single column of cells.
You can change the number of items in the list by changing the number in the Cells property and each
list can be rendered as text or images in the List Render option, among other properties.
Figure 4 shows an example of a widget created for a transit schedule.
Figure 4

Example of Schedule Widget Using List Components

In this example, there is a Graphic component with a background image at the first layer of the widget
(Figure 5). Notice that the route names are built into the fixed graphic on the left side, based on
knowledge of the XML content in the data source for the widget, so that the data bound in the adjacent
List components correlates.
Figure 5

Example of Schedule Widget Background Graphic
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The remainder of the schedule widget uses five single-column list components each containing seven
cells/items in a vertical orientation (Figure 6). These lists display dynamic content from a single data
source through both field mapping and configuration of the expression editor.
For more information about using List components in a widget, see the “Configuration Examples”
section on page 85.
Figure 6

Example of Schedule Widget Using List Components

Data Pull Component
The Data Pull component is a special component that is only needed in a widget for certain data sources
larger than 16 KB and whose data does not need more immediate synchronization across large numbers
(100-200) of DMPs (such as for menu board data).
The Data Pull component changes how the data source is processed by Cisco StadiumVision Director by
pulling the data feed and sending it to the Flash template, which overcomes the 16 KB multicast packet
size normally pushed to the DMP.
In widgets without a data pull component, only specific output fields from the data source are sent using
multicast. Widgets with a data pull component pull all output fields in the data source.

Layers
Similar to standard graphics editing applications, each time a Text Area or Graphic component is added
to a widget, it is labeled in numerical order (by type) as a Layer on the canvas. Unless reordered, the first
component added is at the bottom of the components added to the canvas, and the last component added
is the topmost layer. In the user interface, the Layers box also lists the layers in stacking order with the
topmost layer at the top of the list. In general, a background image should be at the bottom of the list.
You can reorder the layers by dragging and dropping them into a different order in the Layers box of the
Widget tool.
The first graphic component added to the widget is identified as “graphic 1,” and the first text area is
labeled “text area 1.” Components are numbered sequentially as they are added. Therefore, if you delete
a component, that component number is not replaced.

Tip

You can rename a component by double-clicking it.
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Properties and Effects
The Properties panel allows you to set the characteristics of a component including explicitly setting its
size, location, and rotation on the canvas.
Depending on the component type, some additional Properties and Effects are available:
•

Data Pull Component Properties, page 67

•

List Component Properties and Effects, page 67

•

Standalone Text Area Component Properties, page 69

•

Standalone Graphic Component Properties, page 70

•

PicToScreen Component Properties and Effects, page 71

•

TextToScreen Component Properties and Effects, page 72

Data Pull Component Properties
Table 1 describes the property option available for Data Pull component. You can either pull data one
time, or you can set an interval of time to repeat pulling data from the data source.

Note

Although there are dimensional properties for the Data Pull component in the widget, they really do not
need to be set.
Table 1

Data Pull Component Property

Property Name

Description

Values

Pull Once

Gets data from the data source one time and sends it
to the DMP Flash template data registry

Default is
disabled.

Pull Interval (seconds)

Length of time to wait before pulling the data source Range is 15-3000.
from Cisco StadiumVision Director and send it to the Default is 60.
DMP Flash template data registry.

List Component Properties and Effects
Table 2 describes the property options that can be applied to List components.

Tip

Due to the number of the Properties and Effects options for the List component, you might need
to use the resize handle at the top of the panel and/or the scroll bar to see all options.

Table 2

List Component Properties

Property Name

Description

Values

x

Number of pixels that defines the starting position of the
component horizontally.

Range is 0–1920.

y

Number of pixels that defines the starting position of the
component vertically.

Range is 0–1080.
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Table 2

List Component Properties (continued)

Property Name

Description

Values

width

Number of pixels that defines the horizontal width of the
component.

Range is 0–1920.

height

Number of pixels that defines the vertical height of the
component.

Range is 0–1080.

rotation

Number of degrees to rotate the component box.

Range is 0–360.
Default is 0.

Cells

Number of cells defined in the list.

Default is 2.

Cell Width

Number of pixels that defines the horizontal width of the
cell.

Range is 10–1080.

Cell Height

Number of pixels that defines the height of the cell.

Range is 10–1080.
Default is 100.

Vertical align

Vertical alignment of content in the cell.

Possible values are:

Horizontal align

Horizontal alignment of content in the cell.

•

Top (Default)

•

Middle

•

Bottom

Possible values are:
•

Left (Default)

•

Center

•

Right

Grid

Option to control display of cell borders.

Enabled (checkbox
is marked)

Cell Padding

Number of pixels that defines the padding between cells.

Range is 1–20.
Default is 2.

List Order

Alignment of the list component as either a row
(Horizontal) or column (Vertical).

Possible values are:

List Render

Font Name

Rendition type for list component items as either text or
images.

Font style for the list.
Note

Cisco StadiumVision Director only provides the
Arial font by default. To support additional fonts,
you must install them using the Software Manager.

Cisco StadiumVision Director External Content Integration Guide

68

Default is 200.

•

Horizontal
(Default)

•

Vertical

Possible values are:
•

Text (Default)

•

Image

Possible values are:
•

Arial (Default)

•

Available
custom fonts.
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Table 2

List Component Properties (continued)

Property Name

Description

Values

Font Size

Size of the font for text-based list components.

Default is 36.
Maximum is 128.

Font Color

Color of the font for text-based list components.
Tip

Hexadecimal value
of the color or by
Remember that the Widgets tool displays a white
selection in the
background for ease of use, but if you are not using
color grid.
any background images, a black font will not be
Black is the default.
visible on the TV screen because the TV
background is actually black.

Table 3 describes the effects that can be applied to List components.
Table 3

List Component Effects

Effect Name

Description

Values

Background Color
Condition

Background color for the cell property when there is Possible values are:
an increase/decrease of the cell value (for a numeric
• None (Default)
value) or upon change of the value.
• Increase and
Decrease
(Number)
•

On Change

Background color display Length of time to display background color of the
duration (Seconds)
cell property.

Default is 0.

Format

Format to display for list items including number
formats, date formats, and time formats.

Do Not Format
(Default)

Prefix Symbol (max 3
Characters)

Character string to prepend to the list item.

Maximum of 3
characters.

Suffix Symbol (max 3
Characters)

Character string to append to the list item.

Maximum of 3
characters.

Standalone Text Area Component Properties
In addition to setting the size, location, and rotation on the canvas for Text Area components, you also
can specify the character string for the component, and select a font size and color.
Table 4 describes the property options that can be applied to standalone Text Area components.
Table 4

Text Area Component Properties

Property Name

Description

Values

x

Number of pixels that defines the starting position of Range is 0–1920.
the component horizontally.

y

Number of pixels that defines the starting position of Range is 0–1080.
the component vertically.
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Table 4

Text Area Component Properties (continued)

Property Name

Description

width

Number of pixels that defines the horizontal width of Range is 0–1920.
the component.

height

Number of pixels that defines the vertical height of the Range is 0–1080.
component.

rotation

Number of degrees to rotate the component box.

Text

Character string to display within the text area
component.
Note

Values

Range is 0–360. Default is 0.

Default is “TextAreaN,”
where N is a number in
sequential order of the
The Text property does not support line wrap,
number of Text area
so the length of the string that can be
components added to the
supported is the canvas width.
canvas.

Font Size

Size of the Arial font for the Text property.

Default is 36. Maximum is
128.

Color

Color of the Text property.

Hexadecimal value of the
color or by selection in the
color grid.

Tip

Font Name

Remember that the Widgets tool displays a
white background for ease of use, but if you
are not using any background images, a black Black is the default.
font will not be visible on the TV screen
because the TV background is actually black.

Font style for the Text property.
Note

Cisco StadiumVision Director only provides
the Arial font by default. To support additional
fonts, you must install them using the
Software Manager.

Possible values are:
•

Arial (Default)

•

Available custom fonts.

Standalone Graphic Component Properties
In addition to setting the size, location, and rotation on the canvas for Graphic components, you can
import an image and also specify that it retain the dimensions of the original image.
Table 4 describes the property options that can be applied to standalone Graphic components. No effects
are supported for Graphic components.
Table 5

Graphic Component Properties

Property Name

Description

x

Number of pixels that defines the starting position of Range is 0–1920.
the component horizontally.

y

Number of pixels that defines the starting position of Range is 0–1080.
the component vertically.

width

Number of pixels that defines the horizontal width of Range is 0–1920.
the component.

height

Number of pixels that defines the vertical height of the Range is 0–1080.
component.

Cisco StadiumVision Director External Content Integration Guide

70

Values

Designing the Layout of External Content Using the Widgets Tool
Information About Using the Widgets Tool

Table 5

Graphic Component Properties (continued)

Property Name

Description

Values

rotation

Number of degrees to rotate the component box.

Range is 0–360.
Default is 0.

Content Name

Filename of the image to be displayed in the
component.

Unspecified.
Default images
from the system
are used.

Note

Use image original size

The image must be uploaded to the Content
Management System (CMS) from the Control
Panel > Content > Import area of Cisco
StadiumVision Director to be made available
to the widget.

When selected, changes the image size in the
component to the size stored in the CMS.
Note

Default is
disabled.

If you select this option and then unselect it,
the image does not revert to the settings in the
widget.

PicToScreen Component Properties and Effects
Table 6 describes the property options and Table 7 describes the effects that can be applied to
PicToScreen components.
Table 6

PicToScreen Component Properties

Property Name

Description

x

Number of pixels that defines the starting position of Range is 0–1920.
the component horizontally.

y

Number of pixels that defines the starting position of Range is 0–1080.
the component vertically.

width

Number of pixels that defines the horizontal width of Range is 0–1920.
the component.

height

Number of pixels that defines the vertical height of the Range is 0–1080.
component.

rotation

Number of degrees to rotate the component box.

Images to Display

Maximum number of images to display from the data Range is 1–5.
feed.
Default is 5.
Tip

Use default image if no
image present.

Values

Range is 0–360.
Default is 0.

The value of the Images to Display property
should match the value of the “Number of
messages keep” data option for an Atom or
RSS feed data source.

When enabled, replaces any missing images that
might occur from the data feed (up to the maximum
number for display) with a default image.

Default is
enabled.
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Table 6

PicToScreen Component Properties (continued)

Property Name

Description

Values

Content Name

Filename of an image to be used as the default when
default images are enabled for the component.

Unspecified.
Default images
from the system
are used.

Image Duration

Length of time (in seconds) to display the current set Range is 5 to 25.
of images.
Default is 5.

Table 7

PicToScreen Component Effects

Effect Name

Description

Values

Image Duration

Length of time (in seconds) to display the current set Range is 5 to 25.
of images.
Default is 5.

TextToScreen Component Properties and Effects
Table 8 describes the property options and Table 9 describes the effects that can be applied to
TextToScreen components.
Table 8

TextToScreen Component Properties

Property Name

Description

x

Number of pixels that defines the starting position of Range is 0–1920.
the component horizontally.

y

Number of pixels that defines the starting position of Range is 0–1080.
the component vertically.

width

Number of pixels that defines the horizontal width of Range is 0–1920.
the component.

height

Number of pixels that defines the vertical height of the Range is 0–1080.
component.

rotation

Specifies the orientation of the component.

Horizontal or
vertical. Default
is horizontal.

Font Size

Size of the Arial font for the text that appears in the
component.

Default is 36.
Maximum is 128.

Font Color1

Sets a font color for the first text data field in a feed,
and alternates with Font Color 2. If there is only one
message, then only Font Color 1 is used.

Hexadecimal
value of the color
or by selection in
the color grid.

Tip

Remember that the Widgets tool displays a
white background for ease of use, but if you Default is black.
are not using any background images, a black
font will not be visible on the TV screen
because the TV background is actually black.
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Table 8

TextToScreen Component Properties (continued)

Property Name

Description

Values

Font Color2

Sets a font color for the second text data field in a feed Hexadecimal
and alternates with Font Color 1.
value of the color
or by selection in
the color grid.
Default is black.

Font Name

Font style for the component.
Note

Table 9

Cisco StadiumVision Director only provides
the Arial font by default. To support additional
fonts, you must install them using the
Software Manager.

Possible values
are:
•

Arial
(Default)

•

Available
custom fonts.

TextToScreen Component Effects

Effect Name

Description

Values

Fade

Gradually shows the text data field in the component.

—

Message display
duration (Seconds)

Length of time (in seconds) that the text from the data
feed is displayed.

Range is 5–25.
Default is 5.

Data Binding and Preview
After you have mapped the output fields for an external data source, you can bind that data to a
component in a widget and see a preview of that live content feed.

Note

Live data is polled for preview every 15 seconds in the Widgets tool (including for the Data Pull
component). There can be a slight delay before you see an update of the content within a component.
This polling interval is for preview only and is not the same polling interval used in the data source
configuration.
Only certain data fields are supported for the PicToScreen and TextToScreen components. For more
information, see the “Restrictions for Using the Widgets Tool” section on page 62.
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User Interface Characteristics
Figure 7 shows the areas of the user interface for a new widget.
Figure 7

New Widget Interface

The Widgets tool interface supports some of the following functions and characteristics:
•

Multi-selection of components using standard Control key sequences to move components as a
group.

•

Showing or hiding the bounding box of a component.

•

“Zoom-to-fit” function by double-clicking the zoom knob.

•

Change the widget dimensions by double-clicking the widget size in the upper right of the screen.

How to Design the Layout of External Content for Display
This section includes the following tasks:
•

Accessing the Widgets Tool, page 75

•

Creating New Widgets, page 75

•

Working with Images, page 77

•

Adding Text Areas, page 79

•

Showing the Component Bounding Box, page 79

•

Resizing and Rotating Components, page 81

•

Working with Large Data Sources, page 82

•

Binding External Data to a Widget, page 83

•

Modifying Existing Widgets, page 84
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Accessing the Widgets Tool
To access the Widgets tool, complete the following steps:
Step 1

Log into Cisco StadiumVision Director as an administrator.

Step 2

From the main menu, click Control Panel > Widgets.
A dialog box opens for you to select an existing widget or create a new one (Figure 8).
Figure 8

Dialog Box to Open Existing or Create New Widgets

Creating New Widgets
You can create a new widget when you first access the Widgets tool, or you can create a new widget from
within the tool.
To create a new widget from within the tool, complete the following steps:
Step 1

From the menu bar in the Widgets tool, click File > New.
The Create New dialog box is displayed (Figure 9).
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Figure 9

Create New Dialog Box

Step 2

In the Name box, type a name for your new widget.

Step 3

Do one of the following to specify the size of the widget:

Step 4

•

Click Pre-Set size and click the drop-down list to select a predefined dimension (WxH) for the
canvas in pixels.

•

Click Custom Size and specify a number (in pixels) for the width and height dimensions of the
canvas.

Click Create.
The tool displays a white box of the size that you created, with the dimensions that you specified
displayed in the upper right corner (Figure 10).

Note

The background canvas of the widget is actually transparent, but it is not shown with the
graphics-standard checkerboard pattern to ease visibility of the components.
Figure 10

Step 5

New Widget Screen

Click File > Save.
Changes to the widget are saved.
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Working with Images
This section includes the following topics:
•

Adding Standalone Images, page 77

•

Resizing and Rotating Images, page 78

Adding Standalone Images
Images can be added as a background to your layout in the Widgets tool, and they also can be bound to
a data field using the External Content configuration, such as to add a team logo to a score field that will
appear in the widget.
To support the addition of a graphic bound to a particular external source data field, see the “Modifying
the Output Format of a Statistic” section on page 55.
The Widgets tool uses the Graphic component to support the addition of images as a background or in
other places on your canvas.

Prerequisite
Before you can add an image to a widget, you must import the image file into Cisco StadiumVision
Director by going to Control Panel > Content > Import to select and open a file. In the Import Content
dialog box, specify any options and click Upload.

Procedure
To add an image to a widget, complete the following steps:
Step 1

Open or create the widget where you want to add an image.

Step 2

In the Components box, select the Graphic component and drag and drop it onto your widget canvas
(Figure 11).
Figure 11

Tip
Step 3

Drag and Drop Graphic Component on Widget Canvas

Double-click a component to automatically add it to the canvas.
To add an image, be sure that the graphic component where you want to add the image is selected, and
click Change.
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Step 4

In the Select Image dialog box, highlight the image that you want to add and click Select.
The image is added and scaled to the size of your graphic component box (Figure 12).
Figure 12

Step 5

Image Added to Graphic Component

Click File > Save.
Changes to the widget are saved.

Resizing and Rotating Images
Images will automatically scale to the size of the graphic component box in the widget.

Tip

To find the size of your image file, use the List view for your images in Control Panel > Content. Select
your image and look at the size in the Dimension field in the “Other content metadata” box.
You can scale the graphic to its original size after you add it, or if you modify the image size in the
widget, you can revert back to its original size using the “Use original image size” option, which is
recommended.
Figure 13 shows the options available on the Properties panel for a graphic component and displays the
different bounding box handles that can be used to modify the size of a component box.
Figure 13

Graphic Component Properties Panel and Bounding Box Handles

You can modify the size and position of an image in the following ways:
•

Explicitly setting values on the Properties panel.
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•

Selecting the bounding box and using the handles to modify it.

•

With the graphic component selected, select the “Use original image size” checkbox to revert the
image to its original size when imported.

For more information, see the “Resizing and Rotating Components” section on page 81.

Adding Text Areas
A text area component is added to a widget in the same way as a graphic component, but with some
different properties. A text area supports a character string, and font size and color selection.
The default font is Arial. You can specify other fonts for the widget if you have installed custom fonts
for Cisco StadiumVision Director using the Software Manager.
To add a text area to a widget, complete the following steps:
Step 1

Open or create the widget where you want to add the text area.

Step 2

In the Components box, select the Text Area component and drag and drop it onto your widget canvas.

Step 3

In the Properties panel, type the character string for the box, and select the font size and color.
Figure 14 shows the options available on the Properties panel for a sample text area component.
Figure 14

Text Area Component Properties

Step 4

Resize or position the text area as needed. For more details, see the “Resizing and Rotating Components”
section on page 81.

Step 5

Click File > Save.
Changes to the widget are saved.

Showing the Component Bounding Box
When you add a component onto the canvas, a temporary bounding box appears while the component is
selected. If you move away from that component into another area of the canvas, you will not be able to
see the boundaries of the component box.
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Figure 15 shows an example of a text area and graphic component displaying the default setting without
a visible boundary when the component is unselected. Notice that while the graphic component is
selected the temporary bounding box is displayed in Figure 15, but when unselected it appears to
disappear from the canvas (Figure 16).
Figure 15

Default Setting Without Bounding Box and Selected Component

Figure 16

Default Setting Without Bounding Box or Selected Components

To display a boundary around all components in the widget, complete the following steps:
Step 1

From the menu bar, go to View.

Step 2

Click Show bounding box.
A checkmark appears beside the option when the bounding box is enabled for display, and all
components will display a boundary around them.
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Figure 17 shows an example of a text area and graphic component after the Show bounding box option
is enabled.
Figure 17

Step 3

Show Bounding Box Option Enabled

Click File > Save.
Changes to the widget are saved.

Resizing and Rotating Components
You can resize and rotate both Text Area and Graphic components in the following ways:
•

Change the component location:
– Select the component and manually drag it to the location that you want on the canvas.
– Specify the x/y horizontal and vertical values directly in the Properties panel.

•

Change the component size:
– Select and drag a handle on the component’s bounding box to enlarge or reduce the component

size. If using a handle on a side of the box, only that dimension is changed. If using a corner
handle, both dimensions of the box are changed.
– Shift+Click on a corner handle to resize the box proportionally.
– Specify the width and height values directly in the Properties panel.
•

Change the component angle:
– Select the rotation handle and drag the box up or down to rotate it.
– Shift+Click on the rotation handle and drag the box up or down to change the angle in 45 degree

increments.
– Specify the rotation value in degrees directly in the Properties panel.

Figure 18 identifies the bounding box handles that you can use to resize and rotate components.
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Figure 18

Bounding Box Handles

Working with Large Data Sources
Cisco StadiumVision Director truncates data packet to 16 KB due to packet size limits on the DMP, so
usable data plus overhead cannot exceed 16 KB under normal operation. The 16 KB limit is for all
external data referenced in a script (possibly by multiple widgets).
If you are working with certain data sources larger than 16 KB and whose data does not need more
immediate synchronization across large numbers of (100-200) DMPs (such as for menu board data), you
should add the Data Pull component to your widget.
To disable multicast push of a data source in a widget and enable data pull for all fields, complete the following
steps:
Step 1

Open or create the widget where your large data source is bound.

Step 2

In the Components box, select the Data Pull component and drag and drop it onto your widget canvas.

Step 3

In the Properties panel, do one of the following to specify the frequency with which you want to get the
data source from Cisco StadiumVision Director:
•

Click the Pull Once checkbox to do a one-time data pull from the data source.

•

In the Pull Interval (seconds) option, specify the number of seconds to wait before pulling data again
from the data source.

Tip

The Data Pull component is not a presentation component and it will not appear on the display.
It does have dimensions and coordinates but they are not necessary to be applied unless you
simply want to move or resize the component to simplify your view of the rest of the widget on
the canvas.

Step 4

In the Data Binding panel, select the data source.

Step 5

Click File > Save.
Changes to the widget are saved.
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Binding External Data to a Widget
The widget supports the binding of external data to a text area component so that you can display
dynamic output fields, such as game periods, scores, and so on from an external source.

Note

If you add a text string to the component, it will be replaced by the real-time data from the output field
that you specified in the Data Binding panel.

Prerequisite
Before you can bind external data to a widget, you must have configured your external data source and
mapped the output fields by going to Control Panel > Setup > External Content. For more information,
see the “Configuring External Content Integration in Cisco StadiumVision Director”.

Procedure
To bind external data to a widget, complete the following steps:
Step 1

Open or create the widget where you want to add the text area.

Step 2

In the Components box, select the Text Area component and drag and drop it onto your widget canvas.

Step 3

In the Properties panel, select the font size and color. Optionally, specify a character string if you want
to temporarily see some content in the component while the widget is open.
The font size and color will be applied to the bound data.

Step 4

In the Data Binding panel, double-click in the first cell under the Data Source heading and open the
drop-down list (Figure 19).
Figure 19

Step 5

Click the drop-down list and select the data source from which you want to bind data. Use the scroll bar
to reveal all data sources as necessary (Figure 20).
Figure 20

Step 6

Accessing the Data Source List

Selecting the Data Source

Double-click inside the cell for the data field and select the drop-down list to select the data output field
that you want to display in the text area component (Figure 21).

Note

This step does not apply to the Data Pull component, where all fields in the data source are
automatically included and individual fields cannot be selected.
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Figure 21

Step 7

Selecting the Data Field

Click File > Save.
Changes to the widget are saved.

Modifying Existing Widgets
This section includes the following tasks:
•

Changing the Size of a Widget, page 84

•

Deleting Widgets, page 84

•

Renaming Widgets, page 85

Changing the Size of a Widget
To change the size of a widget, complete the following steps:
Step 1

Open the widget whose size you want to change.

Step 2

From the Edit menu, select Widget Dimension.

Timesaver

You can also double-click the widget size in the upper right corner of the screen to open the Change
Widget Dimension dialog box. See the “User Interface Characteristics” section on page 74.

Step 3

In the Change Widget Dimension dialog box, specify the new width and height values.

Step 4

Click Change.

Deleting Widgets
To delete a widget, complete the following steps:
Step 1

From the File menu, select Manage Widgets.

Step 2

In the Manage Widget dialog box, select the widget that you want to remove.

Step 3

Click Delete.
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Renaming Widgets
To rename a widget, complete the following steps:
Step 1

From the File menu, select Manage Widgets.

Step 2

In the Manage Widget dialog box, select the widget that you want to rename.

Step 3

Click Rename.
The widget name is changed to an editable box.

Step 4

Type a new name for the widget.

Step 5

Click Close.

Configuration Examples
This section includes the following topics:
•

Basic Widget Configuration Example, page 85

•

Menu Board Widget Using DMB Themes Configuration Example, page 88

•

TextToScreen Widget with Merged Generic Data Sources Configuration Example, page 100

•

Tabular Widget Using List Components for a Transit Schedule Configuration Example, page 108

Basic Widget Configuration Example
Note

This example demonstrates use of the Text Area and Graphic components with data binding. The figures
are based on the original interface for the External Content Integration feature; Therefore, some of the
figures do not reflect all of the latest available components in the interface.
This section shows a basic widget configuration example to bind external data for an OES Ice Hockey
Scoreboard data source. The example uses an image background (Figure 22) that creates static headings
for Period, Time Outs, and Score, with companion text area components that will be created as layers on
top of the background.
These text areas will be positioned beneath the background image headings and will have real-time data
bound to them to appear in the widget.
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Figure 22

Image Background for Scoreboard Widget

To create a widget and bind data to it, complete the following steps:
Step 1

Create a new widget with size 1920x1080.

Step 2

In the Components box, select the Graphic component and drag and drop it onto your widget canvas.

Step 3

With the graphic component selected, go to the Properties panel and click Change.

Step 4

In the Select Image dialog box, click on the background image that you want to add and click Select.
The image is added and scaled to the size of your graphic component box.

Step 5

In the Properties tab, specify the following values (Figure 23):
a.

x and y—0

b.

width —1920

c.

height—1080

d.

rotation—0

Figure 23

Step 6

Background Image Added to Graphic Component

Create two new text area components to add “HOME” and “GUEST” as the specified text string
positioned as layers on top of the background graphic component (Figure 24).
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Figure 24

Addition of Home and Guest Text Areas

a.

Drag and drop the Text Area component onto the background graphic.

b.

In the Properties panel, specify the following values:
– Text box—Type “HOME”
– Font size—128
– Font color—Choose yellow

Step 7

c.

Select the handles on the text area box and expand its boundaries enough to reveal the text.

d.

Select the text area component and drag it to the left side of the background graphic over the Time
Outs Left and Score fields.

e.

Repeat steps a–d using “GUEST” text and drag the component to the right side of the background
graphic.

Add Text Area components to bind data for Period, Time Outs, and Score areas for both teams:
a.

Drag and drop the Text Area component onto the background graphic.

b.

(Optional) Zoom in as needed to see the component better.

c.

Position and resize the component beneath the heading for which you are going to bind
corresponding data (Figure 25).

d.

(Optional) Add text to temporarily identify what data will be in the box, such as “period_data.”

Figure 25

e.

Text Area Component to Bind Period Data

In the Data Binding panel, select the OES: Ice Hockey, Scoreboard data source and the period data
field (Figure 26).
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Figure 26

f.
Step 8

Period Data Field Binding for OES Ice Hockey Scoreboard Source

Repeat steps a–e for all other data fields that you need to bind.

Click File > Save.
Changes to the widget are saved.

Menu Board Widget Using DMB Themes Configuration Example
This advanced example shows how to create a menu board widget by configuring a data source for a
menu board that uses a menu theme that you have defined in the Cisco StadiumVision Director Dynamic
Menu Board (DMB) application. The benefit of using a DMB theme for your widget-based menu boards
is that it allows you to more easily show categories of items on your menu.
To successfully configure a menu board widget you must be familiar with the content and format of your
menu theme data to be mapped into the List components. If you are using a standard menu theme from
DMB, see the “Appendix A: Default Menu Theme Reference” module of the Cisco StadiumVision
Director Dynamic Menu Board and Store Configuration Guide as a useful reference.
Figure 27 shows the menu board widget described in this configuration example.
Figure 27

Franks Menu Board Widget Example
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This example highlights the following functionality in the External Content Integration Feature:
•

DMB menu theme data source configuration.

•

Selection of output fields for the background image, column headings, menu items, and menu
images.

•

Indexing elements in the XML data using the XPath expression editor to select the fields that you
want to include on your menu board.

•

Widget creation using the following components:
– Graphic
– List
– Text
– Data Pull

Task List
•

Create the Menu Theme in the DMB Application, page 89

•

Create the Data Source for the Menu Theme Widget, page 91

•

Select the Input Fields to be Mapped to the Menu Board Widget, page 91

•

Define the Mapping Expressions, page 94

•

Enable the Data Source, page 95

•

Create the Menu Board Widget, page 95

•

Configure the Background Graphic Component for the Menu Board Widget, page 95

•

Configure the List Components for Each Set of Mapped Data, page 97

•

Configure the Text Area Components for the Group Headings, page 99

•

Add the Data Pull Component, page 100

Create the Menu Theme in the DMB Application
Before you can use a menu theme as a data source, you must create the theme in the DMB application,
or use one of the default themes. For more information about creating menu themes, see the Cisco
StadiumVision Director Dynamic Menu Board and Store Configuration Guide.
In this example, the Franks default DMB menu theme is used as the data source for the menu widget.
Figure 28 shows the layout details for the Franks theme.
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Figure 28

Tip

Franks Layout—Default DMB Menu Theme

As a reference for the Data Integration configuration, you can view the XML data for your menu theme
from the DMB application (Figure 29).
Figure 29

Show XML Icon for DMB Themes
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The “Appendix A: DMB Default Menu Theme Reference” module in the Cisco StadiumVision Director
Dynamic Menu Board and Store Configuration Guide also describes useful details for the default menu
themes, including identification of columns and headers for a better understanding of the field mapping
task in the data source configuration. Figure 31 shows an excerpt of this information from that document
for the Franks layout.

Create the Data Source for the Menu Theme Widget
The Theme Name for the data source must match the name of the theme that you are using in the DMB
application. Figure 30 shows creation of the Menu Theme data source type using the Theme Name
“Franks” for our example.
Figure 30

Menu Theme Data Source Configuration

For more information about creating menu theme POS data sources, see the “Configuring the Connection
to a Menu Theme POS Data Source” section on page 30.

Select the Input Fields to be Mapped to the Menu Board Widget
To perform this task, you need to understand the content and format of the data that you want to display
on your menu board and how the output XML is defined by the Data Integration feature.
In the Franks default menu theme, there are three columns and five headers defined (Figure 31). The five
possible headers to be used in the menu board are: Entrees, Snacks, Beer, Beverages, and Souvenir.

Cisco StadiumVision Director External Content Integration Guide

91

Designing the Layout of External Content Using the Widgets Tool
Configuration Examples

Figure 31

Franks Layout—Columns and Headers

In the XML for POS menu theme data integration, a “Group” instance corresponds to unique
column/header combinations for the theme. Therefore in the Franks theme, there are five possible
groups.
Table 10

Group Identification

Column/Header Combination

Data

Group No.

Column 1 / Header 1

Entrees

1

Column 1 / Header 2

Snacks

2

Column 2 / Header 1

Beer

3

Column 2 / Header 2

Beverages

4

Column 3 / Header 1

Souvenir

5

In our example shown in Figure 27, we will select two groups (Entrees and Snacks), along with two
instances each of item names, images, and prices for each group.
Figure 32 shows an overview of the input fields that are selected for output in our example.

Note

You must drag certain input fields multiple times to create the number of instances that you need on the
menu board. Then, you will need to index the expression to identify each instance.
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Figure 32

Menu Theme Field Mapping Workflow

To select the input fields, complete the following steps:
Step 1

(Optional) To use the background associated with the menu theme for the menu board, do the following:
Tip

Step 2

If you want to use a different background than what is in the theme, you can skip this step and
simply add a graphic component to the widget.

a.

Under the Background list, locate the src field and drag it over to the Output field panel.

b.

In the Add Output Field dialog box, type the name that you want to use or accept the default.

c.

Click OK.

To add groups (categories) for the menu board, do the following:
a.

Under the Group list, locate the name field and drag it over to the Output field panel.

b.

In the Add Output Field dialog box, type a new name for the for the group, such as “gpname1” and
click OK.

c.

Repeat this step for as many groups as you want to add and give each a unique name.
In our example, two group fields called “gname1” and “gname2” were created.

Note

Step 3

In our example, Figure 32 shows that three groups were actually added to the Output field panel
for the data source. However, only two of these groups are actually used in our example widget.
Therefore, realize that more output fields can be selected for the data source than you necessarily
plan to bind in any single widget.

To add items for each group, do the following:
a.

Under the Item list, locate the name field and drag it over to the Output field panel.

b.

In the Add Output Field dialog box, type a new name for the item, such as “itemname1” and click
OK.

c.

Repeat this step for as many items as you want to add and give each a unique name.
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In our example, two item fields called “name1” and “name2” were created.
Step 4

To add images for each item, do the following:
a.

Under the Item list, locate the image field and drag it over to the Output field panel.

b.

In the Add Output Field dialog box, type a new name for the item, such as “image1” and click OK.

c.

Repeat this step for as many images as you want to add and give each a unique name.
In our example, two image fields called “image1” and “image2” were created.

Step 5

To add prices for each item, do the following:
a.

Under the Item list, locate the price field and drag it over to the Output field panel.

b.

In the Add Output Field dialog box, type a new name for the item, such as “price1” and click OK.

c.

Repeat this step for as many images as you want to add and give each a unique name.
In our example, two price fields called “price1” and “price2” were created.

Define the Mapping Expressions
When you add the group name field to the output field mapping, you might notice that the following
default mapping expression is created:
/Menu/Group/@name

Each field of that type that you add will have this same default expression, which means that only one
group would be identified. So, you need to modify this default expression to index each group that you
define, and for each field that you have added.
Figure 33 highlights how the index [1] and [2] is added to each output field to identify each element as
part of Group 1 or Group 2. Expressions indexed for Group [1] will be associated with the Entrees
category, and those indexed for Group [2] will be associated with the Snacks category in this example.
Figure 33

Mapping Expression Example

To define the mapping expression to index each group instance, complete the following steps:
Step 1

In the Output field panel, select the field.

Step 2

Click the pencil (Edit) icon.

Step 3

In the Change Output Field dialog box, go to the Expression option and type [1] or [2] after the Group
label (before the slash) and click OK.
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Enable the Data Source
To enable the data source configuration, complete the following steps:
Step 1

In the left pane, select the data source.

Step 2

Click Deploy.
A message box appears asking you to restart the application.

Step 3

If you have completed all of the changes that you want to make for the data source, restart the application
from the Management Dashboard:
a.

Go to Tools > Data Integration > Restart Application.

b.

In the Data Integration panel, click Play (>).

Tip

The Play button is located on the bottom left of the Data Integration panel.

Create the Menu Board Widget
After you have deployed the POS data source, you need to create a new widget for the menu board. For
full-screen menu boards, 1920x1080 is the common size.
For details about how to create a widget, see the “Creating New Widgets” section on page 75.
Figure 34 shows the different component types that are used to bind the data fields from the menu theme
data source in our example.
Figure 34

Menu Board Widget Components Overview

Configure the Background Graphic Component for the Menu Board Widget
To add a background for your menu board widget, you need to configure a Graphic component as the
first layer on your canvas. This graphic component can either be bound to the source background from
your menu theme data source, or it can be selected from the Cisco StadiumVision Director CMS.
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Figure 35 shows where you can use the Content Name on the Properties panel to browse for an image to
use as the background. If you want to use a separate image for your menu board background, then that
image must be uploaded to the Cisco StadiumVision Director CMS before it can be added to the graphic
component.
Figure 35

Selecting an Image for the Background Graphic on the Properties Panel

Be sure to specify the size for the graphic component that reflects the size of your menu board. For more
information about graphic component properties, see the “Standalone Graphic Component Properties”
section on page 70.
For information about how to add an image, see the “Working with Images” section on page 77.
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Figure 36 shows the alternative way to select a background graphic for a menu theme, by using the Data
Binding configuration. In this example for setting the background, the bg data field that we mapped as
an available output field in the data source is selected for Data Binding for the graphic component. When
you bind the background from the menu theme data source, the image URL to the DMB image gallery
is used.
Figure 36

Binding the Menu Theme Data Source Background

Configure the List Components for Each Set of Mapped Data
For each of the group headings (two) in the example, you need a List component for the item name,
image, and price for a total of six lists (Figure 37).
Figure 37

Six List Components for the Franks Menu Theme Example
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To configure the list components, complete the following steps:
Step 1

Drag and drop the List component onto the canvas.

Step 2

From the Data Binding panel, select the Data Source and Data Field.
In our example, “Franks” would be the Data Source, with the following Data Fields selected for each list:

Step 3

•

name1

•

image1

•

price1

•

name2

•

image2

•

price2

From the Properties panel, specify the settings for each list.
Figure 38 shows an example of the properties set for the selected image list under the Entrees heading.
Figure 38

Image List Component Properties

a.

Set List Order to Vertical.

b.

Set List Render:
– Text—For name and price data fields.
– Image—For image data fields.

c.

(Optional) Click Grid.
This allows you to see borders around the cells.

d.
Tip

(Optional) Specify the location of the list and the cell dimensions.
For the first list, you can just use the component handles to resize the list. As you move list
components on the canvas to align them (Figure 39). From there, you can use the Properties
panel to set all of the other list components to those same dimensions.
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Figure 39

e.

List Component Grid Lines

Specify other properties as desired.

Configure the Text Area Components for the Group Headings
In our example, we configure two Text Area components to create the group headings: Entrees and
Snacks.
To configure the text area components, complete the following steps:
Step 1

Drag and drop the Text Area component onto the canvas.

Step 2

From the Data Binding panel, select the Data Source and Data Field.
In our example, “Franks” would be the Data Source, with the following Data Fields selected for each list:

Step 3

•

gname1

•

gname2

From the Properties panel, specify the settings for each Text Area.
Figure 40 shows an example of the properties set for Entrees group heading.
Figure 40

Text Area Properties
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Add the Data Pull Component
As a best practice for menu board data, which can become sizable, you should add the Data Pull
component to the menu board widget. Although you can see this component on your widget canvas, it
does not appear on the published menu board.
For more information about how to add the data pull component, see the “Working with Large Data
Sources” section on page 82.

TextToScreen Widget with Merged Generic Data Sources Configuration
Example
This advanced example shows how to create generic data sources from RSS feeds, filter the data, and
combine the feeds into a new data source for layout in the Widgets tool. The example highlights the
following functionality in the External Content Integration feature:
•

Generic data source configuration of an RSS data feed.

•

Provision of XML sample data.

•

Selection of specific item ranges in a data feed using the XPath expression editor.

•

Merging of data sources into a data view.

•

Data view configuration as a data source.

•

Preview of received data in the data source.

•

Use of a background graphic in the layout.

•

Overlay of a TextToScreen component with data bound from merged data sources (a data view).

•

Use of color properties in the TextToScreen component.

To create a TextToScreen widget with merged data sources, complete the following steps:
Step 1

From the Control Panel, click Data Integration.
For more information, see the “Accessing the External Content Integration Interface” section on page 23.

Step 2

Add a new Generic Data Source with the HTTP message type.
For more information, see the “Adding a New Data Source” section on page 23.

Step 3

In the Configuration panel for the new Generic Data Source, type the URL to your RSS feed.
Figure 41 creates a new Generic Data Source named “Twins_businessnews” with the following HTTP
URL “http://feeds.reuters.com/reuters/businessNews”. The rest of the configuration uses the default
values.
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Figure 41

HTTP Configuration for First Generic Data Source

Step 4

Click Field Mapping.

Step 5

Click the pencil icon to open the Sample data box, paste the sample XML data from the feed, and save it.
For more information, see the “Providing Sample XML Data for Generic Data Sources” section on
page 39.
Figure 42 shows a portion of the XML data pasted into the Sample data box.
Figure 42

Step 6

Sample Data for First Generic Data Source

Expand the RSS input fields made available from the sample data and select a text-based input field to
be used in the output display.
For more information, see the “Selecting Input Statistics and Mapping to Output Fields for Display”
section on page 42.

Step 7

Select the Expression mapping option and click Ok.
The default XPath expression for the data field is added to the Mapping expression field. For an RSS
title element, the default expression is “/rss/channel/title/text().”

Step 8

Click the pencil icon in the Output field icon bar to modify the XPath expression to filter the data
provided by the feed.
Fore more information, see the “Modifying the Default XPath Expression” section on page 57.
Figure 43 shows a modification to the title data field to add the “item[position()>=2andposition()<5]”
predicate to the default /rss/channel/title/text() expression:
/rss/channel/item[position()>=2andposition()<5]/title/text
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In this example, the data will be filtered to pull the 2nd, 3rd, and 4th items in the title element of the feed.
Figure 43

Output Data Filter Using XPath Expression for First Generic Data Source

Figure 44 shows selection of the “title” field for output display with the modified mapping expression
and the 3 items available for data preview from the RSS feed.
Figure 44

Step 9

Field Mapping for First Generic Data Source

Click the link under Data preview to open the “Preview for” window, and verify the data from the RSS
feed.
Based on the filter used in our example to pull 3 items from the title element, a link named “3 items”
appears under Data preview. Figure 45 shows the preview of the three title items from the first generic
data source RSS feed.
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Figure 45

Step 10

Data Preview for First Generic Data Source with Business Data

Repeat Step 2–9 for the second generic data source whose RSS feed content you want to combine with
the first generic data source.
Figure 46 creates a second Generic Data Source named “Twins_sportsnews” with the following HTTP
URL “http://feeds.reuters.com/reuters/sportsNews”. The rest of the configuration uses the default
values.
Figure 46

HTTP Configuration for Second Generic Data Source

Figure 47 shows the corresponding XPath expression to filter the data to pull the 4th, 5th, and 6th items
from the title element for the second generic data source.
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Figure 47

Output Data Filter Using XPath Expression for Second Generic Data Source

Figure 48 shows the preview of the 3 sports titles filtered from the second generic data source.
Figure 48

Step 11

Data Preview for Second Generic Data Source with Sports Data

To combine content from multiple data sources, click Advanced to create a data view and add the data
sources that you created.
For more information, see the “Working with Data Views” section on page 49.
Figure 49 shows creation of a data view named “Twins_BusinessandSportsnews” with the
“Twins_businessnews” and “Twins_sportsnews” data sources included.
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Figure 49

Step 12

Data View Creation with Two Generic Data Sources Added

Configure a third generic data source that connects internally to the created data view.
For more information, see the “Configuring the Data View as a New Data Source” section on page 54.
Figure 50 shows configuration of the internal HTTP URL using the Cisco StadiumVision Director server
IP address and the name of the “Twins_BusinessandSportsnews” data view.
Figure 50

Step 13

Data View HTTP Configuration

Go to Field Mapping and provide the sample XML data for the combined data sources.
The following is an example of the sample XML used:

Note

The “entry” node is required in the sample data.

<command>
<type>xmlDataFeed</type>
<version>1</version>
<channel>com.cisco.sv.databind</channel>
<xmlDataFeed>
<hashcode>45adde4260b54cb41765345a21efd3dc</hashcode>
<xmlDataFeedEntry>
<name>.Twins_businessnews.title</name>
<value>
<entry index="0">Exclusive:Thermo Fisher weighs Life Tech takeover sources</entry>
<entry index="1">Chesapeake CEO McClendon steps down after year of tumult</entry>
</value>
</xmlDataFeedEntry>

Cisco StadiumVision Director External Content Integration Guide

105

Designing the Layout of External Content Using the Widgets Tool
Configuration Examples

<xmlDataFeedEntry>
<name>.Twins_sportsnews.title</name>
<value>
<entry index="0">Never-say-die Kings rally to haunt Canucks again</entry>
<entry index="1">49ers' Moss: "I'm the greatest receiver ever"</entry>
<entry index="2">MLB investigating doping report involving top players</entry>
</value>
</xmlDataFeedEntry>
</xmlDataFeed>
</command>

After the XML sample data is saved, the data sources are combined.
Figure 51 highlights the new link to 6 items available for preview, which includes the 3 items from the
business data source and 3 items from the sports data source.
Figure 51

Step 14

Data View Field Mapping

Click the link in the Data preview column to verify the content for display.
Figure 52 shows the combined title items from both the business and sports feeds.
Figure 52

Step 15

Data View Field Mapping

Go to the Widgets tool.
For more information, see the “Accessing the Widgets Tool” section on page 75.

Step 16

Create a new widget.
For more information, see the “Creating New Widgets” section on page 75.

Step 17

Add a Graphic component to the canvas and adjust the size to accommodate the title fields from the RSS
feeds.
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For more information, see the “Working with Images” section on page 77.
Step 18

Add a TextToScreen component to the canvas to overlay the Graphic component.

Step 19

Bind the data view data source to the TextToScreen component.
Figure 53 shows binding of the “Twinsbusinessandsports” data source.
Figure 53

Step 20

Data Binding of the Data Source Created From the Data View

In the Properties panel, set the options and choose the font colors.
Figure 54 shows the properties used with black set for the first color, and red set for the second color.
The bound data automatically appears in the widget. Since two different colors were set in the
component properties, the colors will alternate for each message.
Notice that the first message of the combined data that was displayed in the Data Integration preview in
Figure 52 appears in the Widget in black font, followed by the second message in red.
Figure 54

TextToScreen Data Preview of First Message Color
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Tabular Widget Using List Components for a Transit Schedule Configuration
Example
This advanced example shows how to create a generic data source for a transit schedule and map the data
source fields to list components to create a schedule widget. To successfully configure a schedule widget
you must be familiar with the content and format of your XML data to be mapped into the List
components.
This example includes the following tasks:
•

Create the Graphics for the Transit Schedule Widget, page 108

•

Create the Data Source for the Transit Schedule Widget, page 109

•

Provide the Sample XML Data for the Transit Schedule Widget, page 109

•

Map the Data Source Input Fields and Modify the Default Expressions, page 110

•

Create the Transit Schedule Widget, page 113

Create the Graphics for the Transit Schedule Widget
In this schedule example, the sample XML data is known to consist of seven routes and a background
graphic was designed with those fixed route names as part of the graphic along with other creative
elements for the schedule design (Figure 55). This background graphic is uploaded to the Content Screen
in the Cisco StadiumVision Director Control Panel.
Figure 55

Schedule Widget Background Graphic Using Explicit Route Names

Also for this example, the sample XML data is known to provide the following status values:
•

Good Service

•

Service Change

•

Delay
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Corresponding graphics were created and named “Good Service.png”, “Service Change.png”, and
“Delay.png” so that an expression can be created to include status icons that correlate to the text value
of the status fields in the XML data source.
Upload these graphics to the Content Screen in the Cisco StadiumVision Director Control Panel.

Create the Data Source for the Transit Schedule Widget
To create the data source for the schedule widget, complete the following steps:
Step 1

From the Control Panel, click Data Integration.
For more information, see the “Accessing the External Content Integration Interface” section on page 23.

Step 2

Add a new Generic Data Source with the HTTP message type.
For more information, see the “Adding a New Data Source” section on page 23.

Step 3

In the Configuration panel for the new Generic Data Source, type the URL to your XML data source and
configure any other required options.
Figure 56 creates a new Generic Data Source named “lirr_ds” with an HTTP URL for the data source
along with a User Name and Password for authentication. The rest of the configuration uses the default
values.
Figure 56

HTTP Configuration for First Generic Data Source

For more information, see the “Configuring the Connection to a Generic Data Source” section on
page 26.

Provide the Sample XML Data for the Transit Schedule Widget
To provide the sample XML data for the transit schedule widget, complete the following steps:
Step 1

From the Data Integration screen, select the transit schedule data source and go to Field Mapping.

Step 2

Provide the sample XML data for the data source and save it.
For more information, see the “Providing Sample XML Data for Generic Data Sources” section on
page 39.

Cisco StadiumVision Director External Content Integration Guide

109

Designing the Layout of External Content Using the Widgets Tool
Configuration Examples

Figure 57 shows a snapshot of some of the sample XML data for the schedule widget data source. The
“depTime” and “status” fields will be used in this widget example.
Figure 57

Sample XML Data for the Schedule Widget Data Source

Map the Data Source Input Fields and Modify the Default Expressions
In this transit schedule widget example, five output fields will be created from the data source to display
departure times and status in the widget as shown in Figure 58 and Figure 59:

Note

•

depTime1

•

depTime2

•

depTime3

•

status

•

status_icon

The status_icon output field will be created based on the value of the XML status field to look up a
graphic that corresponds to that value from the Cisco StadiumVision Director content library. For
example, the status “Good Service” will have a suffix of “.png” added to create the value “Good
Service.png” (a green checkmark graphic). This requires (as per the introduction to this example) that
you have created a graphic of this name and uploaded it to the Content library in Cisco StadiumVision
Director.

Cisco StadiumVision Director External Content Integration Guide

110

Designing the Layout of External Content Using the Widgets Tool
Configuration Examples

To further understand the field mappings and their corresponding data expressions, consider the
following XML data excerpt for the Far Rockaway route (Figure 58).
Figure 58

XML Route Data for Far Rockaway
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Figure 59

Output Fields for the Schedule Widget Data Source

These five output fields will be bound to five corresponding list components in the Widgets tool as shown
in red in Figure 60.
Figure 60

Example of Schedule Widget Using List Components

To map the data source input fields and modify the default expressions, complete the following steps:
Step 1

Expand the data source input fields made available from the sample data and select the “depTime” input
field to be used in the output display. Name this “depTime1.”
For more information, see the “Selecting Input Statistics and Mapping to Output Fields for Display”
section on page 42.

Step 2

Select the Expression mapping option and click OK.
The default XPath expression for the “depTime” data field is added to the Mapping expression field:
“/stops/stop/routes/route/trips/direction0/trip/depTime/text().”

Step 3

With the “depTime1” output field highlighted, click the pencil icon in the Output field icon bar to modify
the XPath expression to filter the data provided by the feed.

Step 4

In the Change Output Field dialog box, click Expression Editor. Add “[1]” to the “trip” element.
Fore more information, see the “Modifying the Default XPath Expression” section on page 57.
Figure 57 shows an example of the Expression Editor and corresponding string:
“/stops/stop/routes/route/trips/direction0/trip[1]/depTime/text()”.
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Figure 61

Step 5

Repeat this process to add two more output fields and name them “depTime2” and “depTime3” with
corresponding “trip[2]” and “trip[3]” changes made to the default strings in the Expression Editor.

Tip

Step 6

Expression Editor for the depTime1 Output Field

The [1], [2], and [3] syntax added to the trip element specifies that the first trip deptime value,
second trip deptime value, and third trip deptime value are pulled from the XML data. In our
sample data for the Far Rockaway route in Figure 58, you can see that these times will be “2:12,”
“3:12,” and “4:12” as displayed in Figure 60.

In the Field Mapping panel, select the “status” Input field and drag it to the Output field box.
This field uses the expression “/stops/stop/routes/route/status/status/text().”

Step 7

In the Field Mapping panel, select the “status” Output field and click the copy icon.

Step 8

Name the output field “status_icon” and click OK.

Step 9

Complete the following steps to create an expression that will result in finding the icon that correlates
to the status text field value. This field will be used in a list component to display icons beside a list
component for the corresponding text status field as shown in Figure 60.
a.

With the “status_icon” output field highlighted, click the pencil icon in the Output field icon bar to
modify the XPath expression to filter the data provided by the feed.

b.

In the Change Output Field dialog box, click Expression Editor.

c.

Drag the concat and lookupContent functions over to the expression and edit the string to match this
example:
fn:lookupContent(fn:concat('',/stops/stop/routes/route/status/status/text(), '.png'))
This expression results in a string named “statusvalue.png” and the content for a graphic of that
same name will be looked for in the CMS and displayed in the cell.

Create the Transit Schedule Widget
To create the transit schedule widget, complete the following steps:
Step 1

From the Control Panel, click Widgets.

Step 2

Create a new widget of size 1920x1080.
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Step 3

Drag the Graphic component onto the canvas and in the Properties panel, click Change beside the
Content Name box. Select the background graphic file from the Content screen and click Select.

Step 4

Drag the List component onto the canvas and modify the following Properties:
•

Cells—7

•

Vertical align—Middle

•

Horizontal align—Center

•

Grid—Check this to ease the sizing of the component. Remember to turn it off again when
formatting is complete.

•

List Order—Vertical

•

List Render—Text

Note

Step 5

Step 6

When you repeat this step for the “status_icon” output field, be sure to set the List Render
property to Image.

(Optional) Under Effects, set the Background Color Condition if you want a certain background color
to highlight any change in value for that cell, or two different colors for an increase and decrease in value.
a.

Click the corresponding Color Picker to select a color from a palette or specify a specific
hexadecimal number for a color.

b.

In the Background color display duration (Seconds), specify the number of seconds that you want
the cell background color change to remain on the display.

Click Data Binding and modify the following values:
•

Select the name of the data source that you created for the widget.

•

Select the name of the Data Field that you want to map to this component (depTime1).

Step 7

Drag the component on top of the background graphic and resize it to match the size of the first column
on the background graphic.

Step 8

When complete, repeat this process by copying the first List component for the four remaining data
sources:

Step 9

Tip

•

Bind each list to the corresponding output fields that you created (depTime2, depTime3, status_icon,
and status).

•

Drag the components and resize them to match the size of the columns on the background graphic.

•

Once all List components are created and positioned properly, clear the Grid property checkbox.

Save the widget.

If you do not see any preview data from your data source, be sure that you have enabled the data source
configuration. For more information, see the “Enabling the Data Source Configuration” section on
page 43.
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What to Do Next
After you have completed creating a widget, complete the following steps to publish it for display:
1.

Create a playlist from the Control Panel for the widget that you created. Widgets are categorized in
the “By Type” folder under the “widget” type.

2.

Create an event script to run the playlist.

3.

Schedule the script to display the content on a TV.
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This module describes how to monitor and troubleshoot problems with External Content Integration in
Cisco StadiumVision Director.
This module includes the following topics:
•

Monitoring the External Content Integration Log, page 117

•

Troubleshooting NFL GSIS Statistics Problems, page 119

•

Troubleshooting Missing Data Feed Content, page 119

Monitoring the External Content Integration Log
All logging messages for External Content Integration are written to the following log file and location:
/opt/sv/servers/mule/mule.log
While logging can always be seen directly from the Unix console, you can also view messages using the
log viewer in the Management Dashboard. When you start the log viewer, informational messages are
displayed as the default severity level.
The log file is compressed once a day at 24:00.

Starting and Stopping the Log Viewer
If logs are turned on, they increase in size over time, which can lead to disk space issues. Therefore, it
is recommended that you use the log functionality only during troubleshooting.
To start and stop the log viewer, complete the following steps:
Step 1

Log into Cisco StadiumVision Director as an administrator.

Step 2

From the Cisco StadiumVision Director main menu, click Management Dashboard.

Step 3

Using the Management Dashboard drawers, go to Tools > Settings > External Content Integration.
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Step 4

Step 5

Do the following:
•

To start logging, select Start Log Viewer.

•

To stop logging, select Stop Log Viewer.

Click the Play button to run the command.

Modifying the Severity Level of Messages Displayed in the Log Viewer
Caution

The logging service for External Content Ingestion can produce a very large number of messages when
you specify the debug severity level, many of which can be seen only from the Unix console. Be sure to
stop the log viewer or change the severity level of messages being logged, and do not allow the log to
run continuously in debug mode to avoid potential problems with system performance or an unusually
large log file. This can also use a lot of disk space on the hard drive.
The External Content Integration log supports 4 severity levels for messages, and each increasing
severity level is cumulative and includes the logging of all message severity levels below it:
•

Debug

•

Info—This is the default.

•

Warn

•

Error

To modify the severity level of messages displayed in the log viewer, complete the following steps:
Step 1

Log into Cisco StadiumVision Director as an administrator.

Step 2

From the Cisco StadiumVision Director main menu, click Management Dashboard.

Step 3

Using the Management Dashboard drawers, go to Tools > Settings > External Content Integration.

Step 4

In the System panel, click the arrow in the Log Level drop-down list box:

Step 5

Select the severity level of the message that you want to view in the log.

a
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Troubleshooting NFL GSIS Statistics Problems
To troubleshoot any problems with obtaining the NFL GSIS statistics, look at the following areas:
•

Note

Verify that the GSISGameStats.xml file resides on the SIAB server in the root directory.

There are five other GSIS files in this directory, but only the GSISGameStats.xml file is used by
Cisco StadiumVision Director.
•

Verify connectivity to the SIAB server and access to the XML file using the following command
from a Unix console on Cisco StadiumVision Director:
curl -u ‘user:pswd’ ftp://ip-address/GSISGameStats.xml
where user and pswd are replaced with your SIAB server username and password credentials from
the NFL GSIS representative, and ip-address is replaced by the IP address of your SIAB server.

•

Check the External Content Integration logs in the Management Dashboard for FTP errors. For more
information, see the “Monitoring the External Content Integration Log” section on page 117.

•

Restart the External Content Integration application from the Management Dashboard by navigating
to Tools > Settings > External Content Integration > Restart Application.

Troubleshooting Missing Data Feed Content
It might take up to two times your polling interval for data to appear in your preview pane.
To troubleshoot any problems with data feed content not appearing in preview, look at the following
areas:
•

Be sure that you have enabled the data source configuration (click Deploy in the Data Integration
screen). You must deploy the feed to make the data available to the External Content Integration
service. For more information see the “Enabling the Data Source Configuration” section on page 43.

•

Restart the External Content Application. The External Content Application must be restarted
whenever you modify the configuration and save it, and after deployment. For more information, see
the “Restarting the External Content Integration Application” section on page 45.

Undeploying All Data Sources in the External Content
Integration Application
If there is a problem with any data sources in the External Content Integration application, sometimes
the application will not be able to start. If the application gets into this state, you can use the TUI to
undeploy all of the configured data sources to clear the problem.
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To undeploy all data flows in the External Content Integration application, complete the following steps:
Step 1

Log into the TUI as installer on the server using a directly-connected console or SSH client.
The TUI Main Menu is displayed.

Step 2

From the Main Menu, go to Troubleshooting > Undeploy all data sources in Data Integration
(Broker).
A prompt is displayed asking you to confirm if you are sure that you want to undeploy all data sources.

Step 3

Press C to continue.

Step 4

Return to the Main menu and exit the TUI.

What To Do Next
After you log into Cisco StadiumVision Director, you should be able to do the following:
•

Re-deploy any data sources in the Control Panel > Setup > Data Integration screen.

•

From the Management Dashboard, restart the External Content Integration Application.
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